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Course Outline 
 
 
The course runs from 9: to 5:30 pm, with one hour for Lunch, and two 20 minute breaks, 
one in the morning and one in the afternoon.  
 

TOPIC TIME Content 
   

Start- 9:00   
   

1: Introduction   
   

2: Quick Titles to enhance a graphic   
   

3: Toolbox Buttons   
   

4: Toolbars   
   

5: Property Viewers   
   

6: Shadows   
   

7: Lighting    
   

8: Surfaces   
   

9: Libraries   
   

10: The DVE   
   

11: Rolls, Crawls and Path Text   
   

12: Animation   
   

Finish – 17:00   
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AVID Marquee Default screen layout 
(The basic Toolset) 
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Introduction 
 
The Marquee Title tool is one of two titling tools present in Avid editing applications- the 
other is the original Title tool familiar to avid editors for many years.  
While the original title tool has provided many years of service to editors around the 
globe, the Marquee title tool offers many more enhancements and capabilities that allow 
an editor to create titles quite a bit more sophisticated and elegant than the original Title 
Tool.  
 
Why bother learning Marquee?  One reason is that it will do so much more than the 
standard title tool.  For example, the Marquee Title tool has these advantages: 
 

• Full scenes may be created in 3D space, and objects may have true 3D rotations 
• Extrusion allows titles to be created with depth 
• Libraries allow the saving and re-use of work  
• Textures can be applied to surfaces 
• Animation may be applied to all objects in your scene 
• Shadows can be created in many varieties 
• Edge Treatments may be applied for rounded, beveled and other edge shapes 
• Text may be attached to paths (shapes) the operator creates 
• 3 dimensional objects (DVE’s) may be incorporated in your scenes 

 
 
Making The Change 
 
Moving to Marquee need not be a difficult task.  You can begin using Marquee as a very 
simple tool, as simple in fact as the original title tool.  This is possible because a single 
window in Marquee – the Quick Titles window, allows you access to almost all the 
controls of the basic title tool in one place.  You can quickly learn to use Quick Titles and 
be producing graphics with the same look, and speed, as in the standard Title Tool. 
 
As your experience grows, and you begin to look deeper into Marquee, you can begin to 
take advantage of more options for surfaces, textures, shadows, extrusions, rotations, 
libraries and more.  Your understanding of Marquee can grow at your own pace! 
 
You will also discover that Marquee is for more than text.  Its simple geometric shapes 
can be extruded into basic, but full 3D models.  It can create animated backgrounds over 
which your text may be placed.  It can even be used to create animated effects by loading 
up images and font and animating them on the screen.  
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Module 1. Introduction to Marquee 
 
 
The Marquee Title Tool is a very 
powerful program which allows you 
to create very sophisticated titles.  
Marquee supports the creation of 
many types of objects, not just text.  
These objects can be positioned and 
oriented in 3D space. Lights can be 
created in this environment, shining 
on your objects. Rolls and Crawls 
are supported. You can add textures 
to objects. And when it’s all done, 
you can animate every object – 
including the lights! 
 
While Marquee is certainly used for making titles, its 3D object and animation 
capabilities make it much more than just a title tool. It s used to create animated logo’s, 
show openings and even complex effects. 
 
The Marquee Title Tool can be used on several different levels. In this course, we begin 
by exploring its basic features in this module, and learn about its more sophisticated 
features in later modules. In this module, the emphasis is on how simple it can be to 
create a basic title with Marquee.   
 
 
 
 
 
Objectives 
 
At the end of this module, you will be able to: 
 

• Start Marquee from within the AVID application, and switch between the two 
• Choose the title tool you wish to use as a default user setting 
• Identify the windows visible in the Basic toolset 
• Select and modify different Toolsets 
• Create a basic title, including adjusting kerning, leading and Paragraph attributes 
• Modify a basic title 
• Preview and save a completed title 
• Modifying and promoting a title to Marquee 
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Getting Started and Tour 
 
The Marquee Title Tool is tied to the Avid editing application.  It needs to be launched 
from within the editing system.  Once started, Marquee opens as a separate program on 
your computer, and you can the switch back and forth between the Editing application 
and Marquee as desired.  
 
 
 
OpenGL Support 
 
Marquee requires the use of an OpenGL Graphics card. If you attempt to open Marquee 
without this monitor support you will get an error message and Marquee will not open. 
When running on a two monitor system, the left (bin) monitor is often the only one 
running with OpenGL acceleration.  In this case most of the Marquee windows must be 
kept on the left (bin) monitor or they will not draw properly.  Remember this if all of a 
sudden your Preview, Surfaces or Timeline window will not update – the number one 
cause is having that window on the wrong monitor! 
 
 
 

Starting Marquee 
 
Marquee and the regular title tool are started in the same way. 
 
 
 
To open the Marquee Title Tool 
 
► Choose TOOLS > TITLE TOOL or CLIP > NEW TITLE.from the menu in the editing 
application. You may also assign the Title Tool button  from the Command Palette 
to your keyboard for quicker access. 
 
If you have chosen the Marquee Title Tool as your default Title Tool, it will open up.  If 
you have chosen the standard Title Tool as your default, it will open up.  If you have 
chosen neither of these as your default, you will see the following New Title dialogue 
box. 
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You may click on the title tool you wish to use. In this case the next time you open the 
title tool this dialogue will open again.  If you select Persist, the choice you are about to 
make becomes the default Title Tool, and this dialogue box will not appear next time you 
open the Title Tool.  
 
 
 

Changing the default Title Tool 
 
If you have chosen Persist in the New Title selector, you have set the default title tool for 
this user. The New Title dialogue will not appear any more, and the editor will not be 
offered the opportunity to choose between the two Title Tools.  
 
In this case, the editor can access the Marquee Title Settings to turn the New Title 
dialogue back on, or to set the other Title Tool as the default.  
 
 
 
To change the default title tool: 
 
► From the Project Window, select the Settings tab, and double click on the Marquee 
Title Settings 
 

 
 
 
At the top of this settings window: 
 

• Choose Marquee to make the Marquee Title Tool the default. 
• Choose Title Tool to make the standard Title Tool the default. 
• Chose Ask Me to re-activate the New Title dialogue box to appear each 

time you access the title tool. 
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Switching between Marquee and the AVID 
 
As you work, Marquee can be left open for faster access. You will be switching between 
Marquee and your Avid Editing application regularly.  You may do this to quickly make 
titles, or simply to reposition the play head on your Sequence monitor to change the 
reference frame in Marquee. In any case, fast switching between the two applications will 
be necessary. 
 
 
 
To switch between the two applications: 
 
To switch between the AVID and the Marquee Title Tool: 
 

• Click between the AVID and MARQUEE buttons in the Windows taskbar. 
• Hold Alt and press TAB to cycle between applications. 
• Click on any visible portion of either application. 

 
 
 
 
 

The Marquee Environment 
 
Marquee starts up with an array of windows on the screen.  We will be exploring most of 
them in detail, but to help you get your initial bearings, here are the windows you see 
upon startup. Refer to the larger image on page 2 for a better view of the Marquee default 
screen. 
 
Note that there are many other buttons and windows that are hidden in this default view. 
These include buttons for object alignment, frame alignment, layering, locking, and 
accessing views. There are also special windows (Property Viewers) which will later 
allow much more control over Shadows, Lights, Surfaces, Textures and much more. We 
will see how to turn these on later.  
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Monitor Window 

 
This is the window in which you will perform many of your titling tasks. You will type 
here, but also directly apply transforms (change title position, rotation, etc), select and 
align objects, position lights and much more.   
 
The image you see here can be a ‘viewers eye view’, as shown here, or one of several 
alternate views which show your text and graphic objects from different positions in 3D 
space. 
 
Attached to the Monitor Window are the Menubar and Button Bar (top), Toolbox (left), 
Status Bar (bottom) and a Scroll Bar (right). 
 
 
 



Marquee Training Course      Paul Sampson     2007     page  12 

Quick Titles Properties 
 
If you only create simple titles, most of the features you need are located here in this 
combination palette.  Here you can make changes to the surface, Shadows and Edges of 
basic titles.  
 
The options here are accessible, but limited. For more sophisticated work, you will use 
the specific property viewers for each attribute.  For example, there is a separate, more 
fully featured Shadow property viewer. 
 
 
 
Layers 
 
For very sophisticated animations, you may wish to access and manipulate parts of your 
graphic individually.  The layers palette lets you monitor and manage the large number of 
individual objects which might be found in a sophisticated title. It allows you to select 
and manipulate objects which may be hidden from view. 
 
 
 
Transform / Effects 
 
Here are two Property viewers (palettes) nested into one.  Each is accessible through a 
separate tab. The transform palette is for accurate, numerical manipulation of objects. 
The effect properties viewer is used to add edges and extrusion to your selected object. 
 
 
 
Templates Library 
 
This is a tabbed window holding five different palettes: STYLES / MATERIALS / 
TEXTURES / TEMPLATES / SCRIPTS. These are used to add presets settings and looks 
to titles, and also allow you to save your own work as presets for re-use. 
 
 
 

Marquee Toolsets 
 
Marquee is a sophisticated environment, and no single screen layout will suit all tasks or 
all users.  That is why Marquee supports Toolsets, the ability to quickly switch the screen 
display between several preset, or user defined displays. Each Toolset remembers what 
windows were open on the screen, how large they were, and where they were located.  
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From the menubar you can access the four preset screen displays 
 

• Basic   F2 
• Basic Animation   F4 
• Big Monitor    F3 
• Expert Animation   F5 

 

Each of these has an equivalent F key assigned for faster 
switching.  The last item in this list, “Paul 1”, is a user created 
screen layout. 
 
 
 
To switch between toolsets: 
 
►   Select the desired toolset from the Toolset menu, or press the appropriate Function 
key. 
 
 
To Modify an existing Toolset: 
 

• Select the Toolset you wish to modify 
• Rearrange the screen as desired 
• From the Toolset Menu, select Save Current 

 
 
To create a custom toolset: 
 

• Rearrange the screen display as desired 
• From the Toolset menu choose Save As… 

 
 
To delete a Toolset: 
 

• Select the Toolset you wish to remove from the menu 
• From the Toolset Menu choose Delete Current 
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Making a simple title 
 
Our first title will be created using only the initial, visible controls in Marquee.  As 
mentioned earlier there are lots of other controls we will be using later, but for now we 
will see the speed and ease of use in Marquee by creating a basic title.  
 
 
 
 

Starting a Title 
 
Open MARQUEE and it assumes you want to make a title that matches your current 
project- 4x3 or 16x9, SD or HD, with your chosen frame rate and Frame size.  If you 
want to create a title of another size, choose FILE > PREFERENCES > CURRENT TITLE 
and on the first tab you can choose the title format you wish to create. This allows you to 
create titles in multiple formats without needing to change projects. 
 
 
 
 
 

Basic Title Settings in the Toolbar 
 

 
 
Start at the top of the screen by setting the basic font parameters for the characters you 
are about to type.  Later on, we will be adding more buttons (Toolbars) to this button bar.   
 
 

FONT     

Any font installed on the computer will appear in this list.  After selecting one font the 
list selector will remain highlighted.  You may use your UP and DOWN arrows to select 
other fonts, or press a letter to scroll to the first font whose name begins with that letter. 
To apply this font to any highlighted letters, or to choose it for the next leters you type, 
press ENTER.  
 
 

SIZE       
 

• Click and edit numbers into this field.   
• Double click to select entire number for replacement,  then type a new value 
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• Drag up or down on the on the value shuttle .  You may hold CONTROL 
while you drag a value shuttle for finer adjustments,  or hold SHIFT while 
dragging the value shuttle to snap to usefull intervals. 

• Click RESET  to restore the default of 48 points 
 

The units of measurement by default in Marquee are points. You may also switch this to 
Pixels or Percentage of screen height in your preferences (FILE > PREFERENCES > 
CURRENT TITLE > USER INTERFACE tab. The default size is 48 points, and 48 
points = 10% screen height = 48 pixels.  Internally, marquee remembers fonts as a 
percentage of screen height, so that if the frame size changes, the font is still the same 
proportion of the screen height that it started as.  
 
 
KERNING 
 
This adjusts distance between letters.  If you use this control on a text block, the 
kerning of all letters will be changed at once.  Some manufacturers call this Tracking.   
 
Using Kerning Text Field: 
 

If you already have typed your letters with the text tool, swipe a block of letters 
to kern multiple letters at once   or   Swipe a single letter to adjust the space to its 
right only. Then: 
 

• Click and edit numbers into this field.   
• Double click to select entire number for replacement 
• Drag up or down on the on spinners ,  
• Click RESET  to restore the default of 0. 

 
Using The Keybord Shortcuts: 
 

Position the text cursor between two letters, then: 
 

• Use ALT + LEFT arrow to move the characters closer together 
• Use ALT + RIGHT arrow to move he characters further apart 
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COLOR      
 
There are four ways to select color.   
 

• Click on the four-color button  to see a selection of colors you can choose 
from. Simple run your mouse over these swatches to choose a color. 

 

 
 

• Click on a color from the spectrum   at the bottom of the palette 
 

• Click on the eye dropper  at the bottom of the palette (and hold your mouse 
button down) as you drag over the monitor window and select a color from it. 

 

• Click on the Color Picker button  to open the Color Picker. You 
can also open it by double clicking on the color sample swatch next to the four-
color button. 

 

 
 

o Start by selecting the way you want to choose your colors – HSBA  or  
RGBA. HSB stands for Hue, Saturation and Brightness, and is a more 
intuitive interface for choosing colors by eye. 

o Adjust the appropriate sliders to mix your color.  Alpha is available only 
when choosing colors for Gradients.  
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ALIGNMENT      
 

Initially, these buttons are greyed out.  They will become active after you create or 
select a text field.  
 
Alignment is relative to where you first click- not to the screen itself.  The edges of the 
text are adjusted relative to their column borders.  It is possible to have more than one 
column on screen. Your choices are, from left to right above: 
 

LEFT 
 

CENTRE 
 

   
RIGHT 

 
 

JUSTIFY 
 

   
EQUAL 
SPACE 
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SAFE TITLE       
 
Safe Title and Safe Action are turned ON 
and OFF by this button.  The safe action 
area (the outer box) is the region within a 
frame where action is guaranteed to be 
visible on television displays. The safe 
title area (the inner box) is the region 
within a frame where title objects are 
guaranteed to be readable on television 
displays.  
 
Later on when we do alignment, it is 
important to know that if safe area is 
turned ON, alignment is relative to TV 
safe (inner box).  If Safe Title is OFF, 
alignment is relative to frame edges.   
 
 
GRID      
 
This grid appears only in the Monitor 
window, it does not show on Output. It 
creates a 16 x 12 grid, and shows dots at 
the intersection of the grid lines.  The 
lines themselves are not visible.  
 
When the grid is on, objects will snap to 
the grid when you drag them. 
 

 
 
 
 
BACKGROUND      

 
Normally, you see the image in your Editing Application’s recorder as a reference image 
behind your text in Marquee.  This button will hide that reference image and show you 
the text over a black background. The visibility of the background image or animation 
also controls its appearance in previewed and rendered frames.  
 
To change your background image: switch to your editing application, move the 
recorder’s play head to the frame you wish to see as a background in Marquee, and then 
return to Marquee to see your updated image as the background. 
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Using the ToolBox 
 
 
 
 
 
 
 
 

 

The ToolBox is the button bar found on the left side of the Monitor Window.  
The default ToolBox is called the Simplified ToolBox and has 8 buttons. Below 
it are the Roll ( R ) and Crawl ( C ) buttons.  We will explore all the buttons in 
more detail later when we turn on the Full ToolBox which adds four more 
buttons to the ToolBox. For now, we will simply identify these 8 buttons and 
their keyboard shortcuts: 
 

   E     Edit     Used for selecting, moving and manipulating  objects in the 
monitor widow 
 

   T     Text     Create and edit Text blocks 
 

   R     Rotate     Rotate objects 
 

   L     Lighting     View and edit scene lights 
 

   S     Shape     Create vector based objects through Bezier drawing 
 

   M     Rectangle     Click and Drag to create rectangular shapes on-screen 
 

   O     Ellipse     Click and drag to create elliptical objects on-screen 
 

   Z     Zoom     Click in the Monitor Window to zoom into your image.  
Hold CONTROL or ALT while you click to zoom back from your image.  
      
Notice as you hold your mouse over each button a Tool Tip will identify the 
button, and remind you what the Keyboard shortcut is for that button.  
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Creating your on-screen Font 
 
To create our first title, select the Text Tool from the Toolbox. You may wish to use the 
keyboard shortcut T. 
 
Click in the Monitor Window at the position 
you want to place your type.  
 
A RED text bounding box appears. This 
double box indicates you have a text field 
ready for typing. The TEXT JUSTIFICATION 
controls which were previously grayed out are 
now active. Select your alignment and type 
your desired letters. 

 

 
To complete the text entry, click with the mouse outside the current text field, or choose 
another tool from the Toolbox.  
 
 
 
Paragraph font and Leading 
 
Click and Drag with the text tool to create a bounding box rectangle which will contain 
what we now call Paragraph text.   This text will word wrap to match the width of your 
text field. As before, changing the bounding box width will change the wrapping of the 
text.  
 
Pressing ENTER as you type does not technically create a separate paragraph. ENTER 
creates a line break, in which the distance between adjacent lines is identical.  
 
Press SHIFT + ENTER to create a new paragraph. There is different spacing between 
paragraphs than between lines – usually a paragraph break has more space between 
paragraphs. After entering a paragraph break, you will be able to take advantage of 
paragraph spacing and alignment adjustments.  
 
 
 
Changing font Leading 
 
Leading is the distance between lines of text. This can be set on a paragraph by paragraph 
basis. Proceed as follows: 
 

• Select your paragraph(s). Position the cursor within the paragraph you 
wish to adjust.  If you want to adjust multiple paragraphs at the same time, 
swipe multiple paragraphs in the same container with the text tool. The 
shortcut CONTROL + A will select all text in a container. 
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• Hold ALT and use the UP arrow to decrease the distance between lines of 
text. 

• Hold ALT and press the DOWN arrow to increase the distance between 
lines of text.  

 
 
 
Changing Paragraph Spacing 
 
Changing the distance between individual paragraphs is possible if you pressed SHIFT + 
ENTER between paragraphs.  If this has been done, you may adjust paragraph spacing as 
follows: 
 

• Position the cursor within the paragraph you want to adjust the spacing 
after. If you want to adjust multiple paragraphs at the same time, then use 
the Text tool to swipe multiple aragraphs. 

• Hold SHIFT + ALT and use the UP arrow to reduce the space after the 
paragraph(s) 

• Hold SHIFT + ALT and use the DOWN arrow to increase the space after 
the paragraph(s).  

 
 
 
Changing font Kerning 
 

As mentioned earlier, this may be done using the kerning text field in the monitor 
window, or may be done using the following procedure: 
 

• Position the text cursor between two letters, then: 
• Use ALT + LEFT arrow to move the characters closer together 
• Use ALT + RIGHT arrow to move he characters further apart 

 
 
 
Font Bounding Boxes in the Monitor Window 
 
This is the bounding box you saw earlier when 
you typed your original font. It is created by 
clicking with your font tool in a blank space on 
your Monitor Window, or by clicking inside 
some existing font in the Monitor Window. It 
indicates you are ready to type more font into 
this text field. The second red box at the top is 
called the ‘top bar’ and is for visual reference 
only. You will also see a text cursor, the 
insertion point, present in this bounding box.  
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Select the EDIT tool (E ) and click on any text 
field (or indeed any object) to see this 
bounding box and its adjustable handles.  
 
In this case it indicates a selected text field, but 
not one in which you are typing.  With Font, 
the bounding box handles may be manipulated 
to change some word wrapping, positioning 
and gradient settings.  
 
Many people are bothered by the fact the 
bounding box may not always encompass the 
font within it. For example, if you enlarge text 
after typing it in, the bounding box does not 
resize with the font.  This is because normally 
there is no direct correlation between bounding 
box size and font size. The bounding box can 
change other aspects of the font other than size 
(such as word wrapping controlled by 
bounding box width).  
 
Changing the bounding box size on its own 
does not change the font size.  

 

 
You can resize the bounding box (with and without rescaling its contents) using the 
following shortcuts: 
 
 
►   To change Bounding Box size only: 
 

• Change bounding box width to change word wrapping. You are 
resizing the container but not its contents. 

• Change bounding box height to set reference for some alignment 
functions. You are resizing the container without effecting its contents.  

 
 
 
►   To change the bounding box size and Rescale its contents as well: 
 

• ALT + Drag bounding box to freely resize the font. You are Rescaling 
the container contents. 

• SHIFT + ALT + Drag  to rescale the font while constraining font 
aspect ratio – no distortion will be applied to the font. 

• CONTROL + drag to rescale the container and its contents from the 
anchor point, which by default is the centre of the object 
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This third bounding box appears when the text 
Tool active, and the text object is not selected.  
 
As soon as you chose the text tool all the text 
objects on the screen identify themselves by 
showing this bounding box, making it easy for 
you to find the text objects on the screen.  
 
 
 



Marquee Training Course      Paul Sampson     2007     page  24 

Bounding Box Review: 
 
As a review, here once again are the three different Bounding Box styles just presented. 
In all cases, nothing is selected on the screen as we begin: 
 

Select the Text tool (T), and all text fields in the 
Monitor Window are identified with the dashed 
bounding box 

Choose the Text tool (T) and Click (or click and 
swipe) on any font on the screen, and this red 
bounding box with a top bar appears to indicate this 
field is active for typing 

  
 

Select the Edit Tool (E) and click on any on-screen 
font (or other object) and this red bounding box 
appears. The object may now be moved, or the 
bounding box resized.  
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Modifying a simple graphic 
 
Changing your font 
 
After creating the initial graphic, we may want to modify any or all of the settings we 
have already made. Generally, changes to your text will be made in one of three ways: 
 

• Use the EDIT  (E) tool to select a full text block and then change attributes to 
apply changes to that entire block of text 

• Use the text tool (T) and swipe a group of characters and then apply changes to 
the selected characters 

• Use the text tool (T) to position the cursor inside a text block and change the text 
attributes for the characters you are about to type at that position 

 
 
 
Repositioning Objects on screen 
 
This is simple and intuitive.  Use the EDIT tool to click on the object to make its red 
bounding box visible.  
 

• Drag the object to a new position 
• Hold SHIFT as you drag to constrain the motion to straight horizontal or 

vertical motion. 
 
For more accurate positioning, you can use the arrow keys on your keybard. 
 

• Press the arrow keys to nudge the object Up, Down Left or Right in single 
pixel increments. 

• Hold SHIFT as you use the arrow keys to nudge by smaller increments for 
more accuracy.  
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Previewing a Title 
 
While you are working in Marquee, you do not always see the title the way it will look 
when rendered out. The Monitor window does not show your TV Safe colors, and it does 
not anti-alias edges and extruded objects.  The monitor window can also have its quality 
level set so you can work more quickly (at lower quality) or more slowly (at higher 
quality). All these factors can result in the title you are looking at in the Monitor widow 
not displaying its true quality. While everything will look fine when the title is sent to 
your editing system, you may want to preview the results in Marquee first. 
 
We are going to look at how to set the Monitor Window display quality, and then how to 
preview the title in the Preview window.  
 
 
 
To Set the Monitor Window On-Screen quality 
 
You can change the on-screen quality of objects in the Monitor window by adjusting the 
quality level. Decreasing the quality level improves the responsiveness of moving and 
editing objects, but at the expense of visual accuracy. Increasing the quality level 
improves the visual accuracy of objects, but at the expense of responsiveness. The 
Quality setting does not affect the rendering quality. To adjust the quality of rendered 
frames, use the settings in the Render Options dialog box. 
 
 
►   Select VIEW > QUALITY and choose the level of quality for the Monitor Window 
to use. The choices are: 
 

Low Produces lower-quality objects and draws the 
quickest of the available levels. The outlines of 
objects appear faceted. Use this quality level 
when you need the quickest response time 
(feedback) and are not concerned with the visual 
accuracy of the objects. 

  
Medium Produces average-quality objects. The edges of 

objects are antialiased (smooth). This setting is 
the default and is sufficient for most titles.  
Use this quality level as a starting point.  

  
High Produces higher-quality objects but might take 

longer to draw on screen, especially if motion 
blur is enabled. The edges of objects are 
antialiased. Use this quality level when you need 
the highest level of visual accuracy or realism. 
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!   WARNING: The Preview window, and many property viewers in Marquee require OpenGL 
graphic support. On some computers, this may be available on only a single monitor in a two 
monitor system.  In this case, the Preview, and most of the Property viewers must be viewed on 
the OpenGL capable monitor.  

 
 
 
To Preview a Title 
 

• In the case of an animated title, position the Play Head in Marquee at the frame 
you want to see previewed. We will look at how to do this when we discuss 
creating animations. 

• Initiate the render by choosing RENDER > PREVIEW, or use the keyboard 
shortcut CONTROL + / when the monitor window is active.. The Render Progress 
dialogue box appears. For a static title, the render is quite quick. 

 

 
 

• When done, the Preview window opens and the rendered frame appears. 
 

 
 
 
 
 
The finished title in the Preview window can be viewed several different ways. In 
particular, you may wish to view its Alpha Channel directly with the following shortcut: 
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To preview the Alpha Channel of your title 
 

• Before you preview your title, ensure the Background button  in the 
Monitor window is off.  You will see your title over black instead of 
seeing it over the reference frame from your editing system. 

• Initiate your preview with RENDER > PREVIEW or use the keyboard 
shortcut CONTROL + / 

• When your rendered title appears in the Preview window, press SHIFT + 
A to toggle between your title and its alpha channel. 

 

 
Alpha Channel 
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Saving a Title 
 
When your title is complete, we will be saving it. Marquee titles can be saved in two 
different ways. They may be saved directly into an AVID bin (title with media), or may 
be saved without media as Marquee .mqp files. Also in each case you can select SAVE or 
SAVE AS.  SAVE AS allows you to save the title with a new name, SAVE will 
overwrite an older version of the title if it has already been saved.  
 
 
 
To save a title with media to the AVID bin: 
  
Select FILE > SAVE TO BIN or use the shortcut CONTROL + B.  FILE > SAVE ALL 
TO BIN is available if you have multiple titles open and wish to save them all to the bin. 
 

 
 

 
• Type the file name in the Title Name field 
• (Option) If you are saving only the current frame from a rolling, crawling, 

or animated title as a static title, select "Current Frame only (static title)." 
• (Option) Select or deselect "Use Same Save Options as Previous Title, if 

available”.  This is selected if you have already saved a title to a bin 
during this session. When this check box is selected, the title is 
automatically saved in your editing application using the same bin, drive, 
and resolution settings as the previous save.  

• Click OK  
 
Basic titles usually render quickly. More advanced titles, especially animated titles, will 
take longer to render. You can cancel the render at any time by clicking Cancel in the 
Rendering Progress message box. When the Rendering Progress message box disappears, 
your AVID editing application will appear.  If it does not, switch to your Avid editing 
application, as described previously. The Save Title dialog box is open in the editing 
application.  
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In the Save Title dialog box, do the following: 
 

• Choose a bin, drive, and resolution from the pop-up menus. 
• Select or deselect Fast Save (Unrendered), depending on your needs. 

When Fast Save (Unrendered) is selected, the title clip is created in the bin 
but title media is not generated. You must create title media at a later point 
in your workflow. This allows for the faster creation of titles, and they can 
have their media created later (CLIP > Create Unrendered Tite Media).  

• Click Save 
 
 
 
Saving a title without Media: MQP files 
 
If you have a lot of titles to create you may wish to speed up your session by making and 
saving the titles without media.  You may then initiate the creation of title media at a later 
time when it is more convenient.  This will allow you to work faster at the title creation 
stage.  
 
Titles without media are saved as separate files with the Windows extension .mqp.  These 
files are very compact, and can be shared among editors with ease.  For example, a 
sample title could be emailed to another editing facility as an .mqp file, where it would be 
opened from within Marquee and the saved to a bin.  
 
 
 
To save a Title without media: 
 
►   Select FILE > SAVE if the title has not yet been saved, or if you wish to save over an 
earlier version.  Select FILE > SAVE AS if you want to save the title under a new name.  
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To open an .mqp file: 
 
►   Choose FILE > OPEN from within Marquee. In the File Open dialogue box navigate 
to the .mqp file and select it.  Click OK. 
 
Once you have opened the .mqp file, you may use FILE > SAVE TO BIN to create a clip 
and media in your bin. 
 
 
 
Unlike the regular Title tool, Marquee allows you to have many titles opened at the same 
time. You can use the FILE > NEW and FILE > OPEN command multiple times. If you 
have multiple files open you will want to switch between them. 
 
 
 
Switching between titles: 
 
►   From the bottom of the WINDOW menu chose the name of the title you wish to see 
 
 
 
Closing a Marquee title: 
 
►   Select FILE > CLOSE  
 
This will close the current title but leave Marquee open.  Closing a title which has not 
been saved with all current changes will call up the Save Changes dialogue:  
 

 
 

• Save to Bin will save a clip and media to the bin you choose 
• Save MQP will save a marquee .MQP file only, no clip or media will 

appear in the bin 
• No will close the title without saving it 
• Cancel will leave the title open 

 
 
 
Exiting Marquee 
 
Select FILE > EXIT, will close Marquee and offer to save any open titles as it closes.  
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Modifying and Promoting Titles to Marquee 
 
It is possible to modify a title after it has been created. If that title was originally created 
with the regular Title Tool, you can modify it in either title tool. You may modify it using 
the regular Title Tool in which it was originally created (don’t promote the title), or you 
can promote it to Marquee, and have access to all of Marquee’s advanced features as you 
edit the title (promote it).   
 
 

!   WARNING: Once a title has been promoted to Marquee, it can no longer be opened in the 
standard Title tool.  This may be an issue on a show shared by several editors if they do not all 
know how to use Marquee.  

 
 
 
To modify (and replace) a title in the bin: 
 
► Control + Double Click on the title icon in the bin. Edit and save the new version of 
the title. The original title in the bin is replaced, although if it has already been edited into 
the timeline, it remains unchanged there.  
 
If you don’t want to replace the title in the bin, but want to create a separate version, do 
one of the following: 
 

• Duplicate the title in the bin (select it and choose CONTROL + D) to create a 
duplicate which you will not modify. 

• When you SAVE TO BIN from Marquee activate the “Save As New Title” 
checkmark in the Save To Avid Bin dialogue. 

 

 
 
 
 
To modify (and create a duplicate) of a title in the Timeline: 
 
► In the Effects Palette, click on the Options button –  to the left of the word “Title”. 
The title tool opens and you may edit and save the new version of the title. In this case, 
the title in the timeline changes and a new title appears in the bin.  The original title in the 
bin is not replaced.  
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Choosing to Promote the Title or not 
 
When opening a Title Tool title for editing using either of the previous methods, you will 
be offered the opportunity to Promote the title, which means to convert it into a Marquee 
title. This is done in the Edit Title dialogue box.  The title will look the same on screen, 
but will be modified in Marquee instead of the standard Title Tool. 
 

 
 

• Chose Yes to open and edit Title Tool titles in Marquee 
• Chose No to open Title Tool titles in the standard Title Tool 
• Check Persist to have your selection become the default, and this question 

will not be presented to you any more.  
 
If you choose Persist and wish to change your mind later on, you can change the Edit 
Title dialogue back to Ask Me in the Marquee Settings discussed previously. 
 
Also in the Marquee Settings you may  activate Backup Title on Promote. This will create 
an unrendered version of your original Title Tool  title, append the characters [TT] to it, 
and then open the original in Marquee for modification.  
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Exercise 1: Creating a basic graphic 
 
Students will: 
 

• Create a simple graphic in Marquee  
• Preview the actual graphic quality in Marquee 
• Observe the Graphic’s Alpha channel in Marquee 
• Save this graphic to their bin ready for use in the Avid 
• Save the same graphic as an .mqp file 
• Revise the graphic by opening it from the bin 
• Revise the graphic a second time, by opening the graphic from the effects editor 
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Module 2. Quick Titles enhances a Basic Title 
 
 
Objectives 
 
At the end of this module, you will be able to: 
 

• Use Quick Titles to modify the Main Surface of an object 
• Use Quick Titles to add a drop shadow to an object 
• Use Quick Titles to add an edge treatment to an object 

 
 
 
 

Introduction to Quick Titles 
 
Most titles will need to be more sophisticated than the ones we made in the last module.  
Specifically, they may require the use of opacity controls, gradients, lighting, drop 
shadows and edge treatments.  
 
All these features are available in a basic form in 
the Quick Titles window. As stated previously, 
many of these features are also available in their 
separate Property viewers in which there are many 
more options than we will see in Quick Titles.  
Still, Quick Titles allows for rapid access to the 
most commonly used controls.  
 
There are four distinct areas of the Quick Titles 
window: 
 

• Master Opacity Control at the top right 
• Main Surface Controls adjusts the fill of 

the letters 
• Drop Shadow Controls 
• Edge Properties allows the creation of 

borders and various edge treatments 
 
To use any of the controls in the last three sections 
you need to activate that part of the window by 
adding a check mark beside its name. 
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Master Opacity 
 
This control adjusts the opacity of the selected object.  If you look closely at the Quick 
Titles you see there are four opacity controls. This one is the Master, meaning if you 
adjust it you are changing the opacity of the letters, their fill and their edge treatment at 
the same time.  You can use this control to fade the entire object up or down. The other 
three opacities only affect their category.  For example, the Drop Shadow opacity only 
adjusts the opacity of the shadow. 
 
 
 

Main Surface 

 
The ‘Main Surface’ is essentially the fill 
of the letters.  
 

 
 

Base      
 
This is the base color. The control will look familiar because we saw it earlier in the 
Toolbar at the top of the monitor window.  It works the same way here too.  
 
One thing to note- it is called Base Color for a reason.  When you create a gradient, it 
may be mixed with or ‘tinted’ by the base color. The base color is added to your gradient. 
The same effect is present when using Textures- the base color will tint the texture.  If 
you don’t want any of this tinting, then make sure the base color is white! 
 
 

Opacity      
 
This changes the opacity of the fill only. If you set it to 0 you will still see the shadow, 
and the border or edge treatment.   
 
Creating the outline of a letter would be done by setting the opacity to 0 on font with a 
border.  
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Enable Lighting      
 
Turning this on allows the position, intensity and color of the lights in Marquee to be 
applied to the fonts main surface (fill).  Clicking this button turns on a single, default 
light.  It is positioned in the upper left of the Monitor window.  Other lights (up to 8) can 
be added to the scene and controlled with the Lighting Properties Viewer.  
 
 
 
Enable Gradient      
 
Activate this option to apply a gradient to 
the surface of the selected object. After 
activating this check box, you can choose 
start and end colors for the gradient, and 
the mid point of the gradient.  You can 
change gradient direction, color, opacity. 
You can add as many as 8 “color stops” to 
the gradient.  
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Setting Gradient Colors 
 

 
The ramp, by default from black to white, shows the colors being used to create the 
gradient. The two triangles under the ramp are the ‘color stops’ where you define the 
gradient start and end colors.  Each gradient must have at least two color stops.  To 
change the color of a color stop: 
 

• Double click on the color stop to open the color picker we used earlier 
• Right click on the color stop to access the color menu 

 
The small triangle at the top of the gradient is used to set the midpoint of the gradient 
between two color stops. It is called the Color Weight. 
 
To add more color stops to your gradient: 
 

• ALT + CLICK below the gradient 
 
 
Tinting a Gradient      
 
The tint checkbox is the control which applies the base color as a tint to the gradient. 
Here we see a blue to white gradient, both with a green tint (left) and without tint (right). 
If you don’t want the base color to affect the gradient, be sure to leave Tint off.  
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Gradient Transparency 
 
Color stops in a gradient have the ability to remember 
not just color but transparency values as well. Here is 
the color picker for a gradient. The apha is adjusted with 
the bottom ramp in this palette, labeled ‘A’, currently 
set at 50%. Notice the sample swatch at the top of the 
palette which shows the results of this setting: blue with 
transparency. 
 

Gradient Color Picker 
 
 
 
Gradient Direction          
 
These three buttons allow you to choose the direction of the gradient.   
 

►   If you click the button a second time, it will reverse the 
direction of the gradient. 
 

Horizontal Vertical Radial 
   

 
 
 

Gradient Rotation      
 
Horizontal and Vertical gradients may also be rotated to any angle using this control.  
 

• Type in a number of degrees by which you want to rotate the gradient 
• Click and drag on the value shuttle  
• Click on the reset button  to reset the rotation to 0 
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Container Mapping 
 
Gradients can be mapped (applied) to objects in one of three 
ways. You can choose Local, Container or Reflection 
mapping.  Reflection mapping is not very effective with a 
gradient and would usually be used with a texture.  

 
 
 

 
 

 
 

Local Container Reflection 
   

Gradient is applied 
to each object in a 
container (each letter 
in your text) 
individually 

Gradient is applied to all objects 
in the container (all letters in your 
text) as if they were one object 

Gradient is applied as if it were being 
seen as a reflection on the surface of 
your object. Gradient is enlarged and 
softened as a result 

 
 
 
 
Adjusting Gradient Distance 

 
 
For a container gradient, you can adjust the distance over which the gradient is applied to 
the container. This is done by changing the size of the container bounding box, as shown 
above.  
 
 
 



Marquee Training Course      Paul Sampson     2007     page  41 

Gradient Review 
 
Now that we have explored the parts of the gradient palette, here are the steps for 
preparing a gradient: 
 

  
  

 
 

Activate ENABLE GRADIENT 

 
Select gradient type, Horizontal, Vertical, Radial .  
Notice the gradient is applied to each letter 
individually. This is a LOCAL gradient  

  

  
  
In most cases, we want a gradient that fills all the 
letters (fills the container) uniformly.  Select 
Gradient Mapping – LOCAL, CONTAINER or 
REFLECTION. This is a CONTAINER gradient. 

 
 
The gradient may be rotated using the ROTATE 
control 
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The position of the gradient center point may be 
adjusted by dragging the top triangle called the color 
weight.    
 
The position of the gradient START or END point 
may be adjusted by dragging either of the bottom 
triangles, called color stops. 

ALT + CLICK below this gradient to add other 
colors – color stops – to your gradient. 

 
 
To select Gradient colors, RIGHT CLICK on a 
color stop to see the Color Menu, DOUBLE 
CLICK on a color stop to get the Color Picker.  
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Drop Shadows 
 
Enable Drop Shadows      
 
Click this checkbox to activate the 
following drop shadow controls.  
 

 

 
 
 

Shadow Tool      
 
The white square represents your object.  Click and drag on the white square and the 
shadow will begin to drag from underneath it.  Drag the shadow into its initial position 
this way.  
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Opacity      
 
Adjust this for the desired shadow opacity.  You can type in an opacity value, use the 
value shuttle, or use the reset button.  
 
 
X and Y Offset     
 
For precise and repeatable shadow offsets, use these controls to position the shadow 
under your object.  X offset controls left-right movement.  Y offset controls Up-Down 
position.  
 
 
Softness      
 
This control is used to adjust the shadow edge.  A higher number is a softer edge. 
 
 

Shadow Color      
 
This control adjusts the color of the drop shadow.  Black is the default color. It is used the 
same way that all other similar color controls we have looked at are used.  
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Shadow Review 
 

  
  

 
 

Activate SHOW DROP SHADOW check box 

The drop shadow appears, and may now be 
adjusted. 

  

       
  
The shadow position may be adjusted as on the 
Media Composer, by dragging the shadow out from 
behind this white box.  The Shadow Position may 
also be changed numerically using the X Offset 
(left/right position) or the Y Offset (up/down 
position).  You can make these X and Y 

adjustments using the value shuttles  , or return 

to the default values using the reset buttons . 
 
 

 
 
The shadow Opacity and Softness may also be 
adjusted using numbers, value shuttles or the Reset 
button.  
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Shadow color may be adjusted with the Color 
Picker or the Color Menu, as shown previously. 

 A drop Shadow with an offset of 0 is of course a 
glow! 
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Adding an Edge  
 

 
 
 
Enable Edge Properties     
 
Activate edge properties to add these 
edge treatments.  
 
Marquee Quick Titles offers many 
choices for edge treatments. You can 
add a simple border (called 
MCBorder), or more sophisticated 
edges (such as Round, Neon, Emboss 
or Ridge).  A Rounded edge is shown 
above.  
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Edge Type      
 
Here you choose the edge type. The default is Default and is in fact no border at all. 
MCBorder is a simple border, similar to a standard Title Tool Media Composer Border- 
hence the term MCBorder. Other edge treatments provide a wide variety of ‘looks’ for 
your lettering and other objects, as shown below:  
 

Bevel Bevel Ridge

    

Bevel Wide Box

    

Chisel Emboss

    

Flat Border Frame
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MC Border Neon

    

Ridge Ridge Inset

    

Round Tube

 
 

►   Enable Lighting must be on for an edge to be seen properly. 
Without a light on the object, there is nothing to show up the new 
edge shape.  Always use ‘enable lighting’ with edge 
enhancements.  
 
 
►   All edges are shown as aliased in Marquee.   To see an anti-
aliased edge, preview the title (Render > Preview or CONTROL + /) 

 

  
Aliased edge seen  

in Marquee 
Same title shown in Preview 

Window 
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Base Color      
 
This control adjusts the color of the edge.  White is the default color. It is used the same 
way that all other similar color controls we have looked at are used. In most cases, the 
edge color you choose should match the Main Surface color, so the lettering appears to be 
made of a single, solid color.   
 

►  The sure way to copy an objects Main Surface color to an edge 
color is to use the  eyedropper to sample the main surface color 
swatch in the Quick Titles window.  The swatch is a pure color, 
while the on screen main surface may be under the influence of 
lights which change its brightness.  

 
 
 

Edge Opacity      
 
Adjust this to change the edge opacity only.  For some edges, such as emboss, this 
softens the look of the edge effect. 
 
 
 
Edge Size     
 
Adjust this to change the edge size. For a regular border, this is border width.  Similarly, 
for other edges, it is the width of the edge effect.  
 
 
 
Enable Lighting      
 
On its own, this enables the single local light.  For edges this is very important. If you 
don’t turn on the lighting, you will see the edge as simply a fattening of the letters.  
 

► Always use the Enable Lighting with edges so you can see them properly.  
 
 
 
Enable Gradient      
 
As with the Main Surface, mentioned earlier, these controls will apply a gradient to the 
edge. They work the same as the Main Sufrace controls.  
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Exercise 2 
 
The students will create a title graphic which contains the following elements: 
 

• A Gradient 
• A Drop Shadow 
• A treated edge 

 
Kerning and Leading of the graphic will also be required.
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Module 3: Toolbox Buttons 
 
 
We’ve already done a lot with Marquee, and we haven’t even looked at all the toolbox 
buttons yet! In this section we will catch up on the Monitor Window controls, the buttons 
at the top of the monitor window and the Toolbar along the left of the Monitor Window.  
Finally, we will begin to explore some of the extra windows or pallets – called ‘Property 
Viewers’ – that offer much more control over every aspect of your title. You may have 
made a shadow, but the Shadow Property Viewer gives so many more options! 
 
 
 
Objectives: 
 
At the end of this Module you will be able to: 
 

• Identify all parts of the Monitor Window, including the Status Bar 
• Use all the buttons in the Simple Toolbox 
• Activate the Full Toolbox and identify the four new buttons 
• Use Drawing Tools to create Shapes 
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The  Monitor Window in detail 
 

 
 
The monitor window is where we have been creating our type. It is here we directly apply 
changes to our objects- select them, rotate, reposition, align and distribute them. The 
monitor window has several views, adjustable magnification and a Status bar at the 
bottom to provide valuable feedback.  
 
We will be looking more closely at the toolbar at the top of the monitor window, the 
Status bar at the bottom, and the Toolbox button bar) at the left side. 
 
 
 

Status Bar 
 
Starting at the bottom of the Monitor window, we have the status bar. From the left, we 
have the following indicators: 
 

• Messages- this one identifies the current layer as a 3D layer 
• CAPS LOCK on/off 
• NUM LOCK on/off 
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• Number of selected objects 
• Current park position – When you are creating animated scenes, click and 

drag on this number (scrub) to move along the default 5 second timeline 
• Current Magnification – click here for a popup you can use to choose other 

magnifications 
 
Notice the button at the right of the status bar, just above it .  This button will reset the 
Monitor Window to the “Scene View”.  It will show the entire scene in the Monitor 
Window from the point of view the audience will see it. 
 
 

More Simple Toolbox buttons 
 
While we named all the buttons in Module 1, and learned how to use the Edit and Text 
tool, there are many more to explore. Here we will be looking at what the other buttons in 
the Toolbar can do for us.  
 
 

 

 

   E     Edit     Selecting, move and manipulate objects in the monitor widow 
 

   T     Text     Create and edit Text blocks 
 

   R     Rotate     Rotate objects 
 

   L     Lighting     View and edit scene lights 
 

   S     Shape     Create vector based objects through Bezier drawing 
 

   M     Rectangle     Click and Drag to create rectangular shapes on-screen 
 

   O     Ellipse     Click and drag to create elliptical objects on-screen 
 

   Z     Zoom     Change magnification in the Monitor window  
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Rotate Button     R      
 
This tool is used to freely rotate an object in space.  
Don’t confuse it with a similar tool in the Full 
Toolbar called the TUMBLE tool.  The Tumble 
tool changes the local view only, it doesn’t 
actually rotate any objects. 
 
Objects can be rotated individually, or by selecting 
multiple objects or grouping them, may be rotated 
in groups.  
 
Rotation may be added in two ways: use this 
ROTATE tool to manipulate the object in the 
Monitor Window, or use the Transform Palette to 
rotate (or reset rotation).  
 
Select the objects and activate the Rotation tool: 
 

• Select and object with the Edit tool and then choose the Rotate tool 
• Chose the Rotate tool first and click on the object you wish to rotate 

 
Multiple objects may be selected using the standard SHIFT and CONTROL click 
operations. 
 
A RED bonding box outlines the object being rotated. 
Also, three axis lines appear which extend out from 
the object to join three circular rings which will be 
used to rotate around each axis.  The overall 
impression is one of the object being contained inside 
a ball or sphere. The three straight lines emanating 
from the centre of the ball are: 
 
• A BLUE axis runs from top to bottom.  

This is the Y axis 
• A GREEN axis runs from front to back.   

This is the Z axis 
• A YELLOW axis runs from left to right.  

This is the X axis. 
 

 
 

There is also a circle in the color of each axis.  By clicking and dragging on one of these 
circles, you can rotate the object in the appropriate axis.  Hold SHIFT as you drag to snap 
in 15 degree increments. 
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The point where these three axis meet in the centre of the sphere is the point around 
which rotation occurs. This is the Anchor Point for the object, and it can be changed. At 
the end of each of these axis is a cross + . This marks the point of rotation for the 
individual axis.  You can click on this mark and reposition it to reset the axis of rotation, 
and in so doing you are changing the Anchor Point for the object. 
 

If you right click on an object selected for rotation, the 
context menu will allow you the option of resetting the 
rotation, or resetting the Anchor Point for the object.  
 

 
 
When repositioning objects which have been rotated, these two keyboard shortcuts will 
be valuable: 
 

• To reposition a rotated object within its local plane, along its own internal 
axis, hold CTRL + ALT and drag with the edit arrow. The object moves 
along its own X,Y and Z. 

• To move the object along only one of these axis at a time, hold SHIFT + 
CTRL + ALT and drag in the direction of the axis to which you want the 
movement constrained.  

 
 
 

Rectangle Tool     R           
 
A rectangle is another type of object you can create in your scene.  As such, all the 
options we explored in Quick Titles can be applied to the shape.  Also, all the Properties 
viewers we will be visiting shortly can also be used on Rectangles and Ovals.   
Sometimes, we may draw a rectangle or an oval and then edit its shape using the SHAPE 
tool to arrive at a more sophisticated object. 
 
You may begin by setting the parameters for the object you are about to create.  If you 
want the new object to look like one already on the screen, select that object with the 
EDIT tool (this will load its settings up in the various property viewers) before you 
choose the rectangle tool and draw an ellipse.  
 
 
To draw a rectangle: 
 

• Click and drag with this too to create a rectangle 
• Hold SHIFT as you drag to constrain the shape to a square 
• Hold CONTROL as you drag to draw a square from the centre 
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To round the corners of a rectangle, you must first select the rectangles. You may now: 
 

• From the menu’s at the top of the screen choose OBJECT > SET 
CORNER RADIUS and choose a corner radius 

• If the Rectangle button is active, you may right click on the rectangle and 
choose Set Corner Radius from the context menu. 

 
 
 

Ellipse Tool     O       
 
You may begin by setting the parameters for the object you are about to create.  If you 
want the new object to look like one already on the screen, select that object with the 
EDIT tool (this will load its settings up in the various property viewers) before you 
choose the Ellipse tool and draw an ellipse. To draw an ellipse: 
 

• Click and drag with this too to create an oval 
• Hold SHIFT as you drag to constrain the shape to a circle 
• Hold CONTROL as you drag to draw an oval from the centre 

 
 
 

Shape Tool     S       
 
The shape tool is used to both draw and edit shapes.  It is in many respects a basic Bezier 
drawing tool, and if you have used Bezier editing in any other program you will find 
Marquee quite similar.  
 
The shape tool can edit circles and rectangles you drew using the other Shape drawing 
tools.  The Marquee manual and Marquee Help file have lots of information and advice 
on how to use this tool.  To get you started here some guidelines: 
 
 
To draw a shape: 
 

• Ensure no other shape is selected before you begin 
• Click to create the starting point for your shape 
• Click to create subsequent points along the shape 
• To complete a closed shape, click on the initial (start) point  
• To complete an opened shape (path), click ESCAPE / Select another tool / right 

click the mouse button. 
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This shape will consist of segments (lines) joined by corner points only (sharp turns at 
each point).  You can create curved (true Bezier) points by clicking and dragging as you 
add points to the shape.  
 
 
 
Selecting Points on a Shape: 
 
Editing a shape often begins with selecting one or more points on the shape itself.  To do 
this, chose the Shape tool, then select points as follows: 
 

• Click on an individual point 
• Shift + Click on additional points to add them to the selection 
• Control + Click on points to alternately add or remove them from the 

selection 
• After choosing at least one point on a shape, drag to lasso other points on 

the shape 
• To select all points on a shape, right click and choose Select All Points 

 
 

This is an open shape made of line segments 
joined by corner points. The three points on 
the left are hollow, indicating they are not 
selected. The three points on the right are 
solid, indicating they are selected.  

 
 
 
To add a Point: 
 

• Alt + Click on the segment (line or edge) of a shape to add a point there 
• Right click on a shape and choose Add Point from the context menu 

 
 
 
To Delete a point: 
 

• Select the control point and press the Delete key 
• Right click on a point and chose Delete Point from the context menu 
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To move a point: 
 

• Click and drag the point 
• Hold SHIFT + CONTROL as you drag to constrain movement in the 

direction you first drag the point 
• Hold SHIFT as you drag if the object has been rotated and you want to 

drag the point along its local axis 
 
 
 
To change the type of a curve: 
 

• To make a corner point, right click on a point and choose Make Cusp 
• To make a smooth Bezier corner, right click on a point and choose Make 

Smooth 
 
 
 
To Open up a shape: 
 

• Right click on a point and choose Split Point. This point will now be split into two 
separate, overlapped points. Drag one out of the way to see both points. 

 
 
 
To close an open shape: 
 

• Drag one point on top of the point you wish to join it on to. 
 
 
 
To delete a segment (line) from a shape: 
 

• Right click on a segment and choose Delete Segment 
 
 
 

Zoom Tool     Z       
 

• To zoom IN Click on title to zoom in at that spot 
• To Zoom In use the keyboard shortcut Control + = 
• To Zoom Out hold Shift  or  Control as you click 
• To Zoom Out use the keyboard shortcut Control + - 
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While not using the Zoom tool, these are some other methods to change the 
magnification of the display: 
 

• To see the entire title choose View > Zoom to Fit 
• To see the entire title use the keyboard shortcut Control + 0 
• To see the title at 100% size on your screen choose View > Actual size 
• Click RESET in the Monitor Window 

 
 
 
Zoom Shortcuts 
 
There are two shortcuts you will want to learn to use when you are zoomed in on your 
monitor window: 
 

• PAN: Allows you to scroll around the monitor window when you are 
zoomed in enough that the entire scene is not totally visible.  Hold the 
RIGHT mouse button, hold CONTRL and drag in the monitor 
window. 

• ZOOM: Another method of zooming is to interactively zoom.  Hold 
the RIGHT mouse button with SHIFT and CONTROL and drag up or 
down to zoom in and out 
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The Full Toolbox 
 
When you start Marquee with the basic Toolset, you receive the basic toolbar.  This 
toolbar is simple, but missing 4 buttons which are available in the Full toolbox. Activate 
the full toolbox as follows: 
 

• To access the Full Toolbox, chose View > Toolbox > Full 
 
The Simple toolbox (left) has fewer buttons than the Full Toolbox 
(right).  The four new buttons are: 
 

A        Animation      
Activates Animation mode, which we will discus in a future 
module. 
 

Y        Page      
Used to create new ‘Decks’, which is a collection or sequence of 
pages, all within the same ‘title’. 
 

V        Tumble      
Allows you to reposition or ‘tumble’ the scene to various angles so 
you can observe the position and relationship between objects in 
your scene.  This tool does not affect the final output the audience 
sees- it is a working view only.  
 

H        Pan      
When you are zoomed in and only seeing a part of your title, click 
and drag on the screen with this tool to pan left/right or Up/down 
within the monitor window. 
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Tumble Tool 
 

 
 

 
Before tumbling, these letters are seen straight 
on and it may be difficult to know that they are, 
indeed, letters with depth. 

After tumbling, we can see the letters from a 
sideways view and the letters depth becomes 
obvious.  

 
 
 
When you use the tumble tool, or indeed any view 
that is not the default view, you will see the gray 
grid superimposed on your image.  This simply 
indicates you are not looking at the standard view, 
and the grid itself offers a reference for your 
viewing. Also attached to this grid are three axis 
indicators showing the position of the global X, Y 
and Z axis from your current view position.  

 
 

The TUMBLE tool  allows flexible 
Viewing in 3D.  At first glance, it looks like 
the rotation tool, but notice it is grouped 
with the other tools used to navigate around 
the Monitor Window.  To use it, activate the 
button and then simply click on the Monitor 
Window and drag to view your scene from 
almost any orientation.  
 
Remember you can select other views as 
shown previously, or return to Scene View 
(what the audience will see, a view from the 
‘front’) by pressing the Reset   button in 
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the lower right corner of the Monitor 
Window.  

 
 
Tumble Tool shortcut 
 
You will use the tumble tool so often you might like to learn its shortcut.  While holding 
down the RIGHT mouse button, hold CONTROL and ALT down and drag in the monitor 
window with your mouse to tumble on command! 
 
 
 

Exercise 3 
 
Students will create a simple text graphic and then: 
 

• Rotate the text slightly 
• Draw a circular or rectangular shape beside the text 
• Edit this shape using the pen tool 
• Zoom in and out on their graphic to explore it better 
• ‘Tumble’ the scene to see the shapes relative positions better 
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Module 4: Toolbars 
 

Objectives: 
 
In this module we will learn: 
 

• How to customize the Toolbars 
• How to use the toolbars for alignment, grouping, layering, locking 

and selecting views 
 
 
 

Customizing the Toolbars 
 
After creating our basic type, we might 
begin looking for more sophisticated 
tools for layering, grouping, locking, 
aligning, and distributing our text.  The 
controls to do this are available in 
Marquee, and by default they are not 
visible.  To perform these functions, we 
begin by making these extra buttons 
visible on our screen.  
 
From the VIEW menu, begin by 
activating (placing a check mark beside) 
all the selections in the TOOLBARS 
menu.  This will make all the Marquee 
buttons visible.   
 

 
A toolbar will initially appear as a floating window.  If you want to dock it with the other 
toolbars, drag it into position in the Toolbar area and drop it.  Toolbars within this area 
may also be dragged to new positions within the toolbar.  
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TO MAKE THESE CHOICES PERSIST, save them in a toolset, otherwise the next time 
you open Marquee they will be gone again. 
 

 
 

Default button bar 
 

 
 

Full Button Bar with all Toolbars displayed 
 
 
 
The new toolbars which will appear are: 
 

Standard New title, Open Title, Save Title 
   

Object 
Layering Front, forward, backward, back 

   

Object 
Editing 

Group, Ungroup 
Lock, Unlock 
Object Position 
Object Alignment 
Object Distribution 

   

Views Scene, Left, Front, Right, Top 
 
 
 
 
 

  STANDARD TOOLBAR   

  
   

 New Title   CONTROL + N Make a new title 
    

 Open Title CONTROL + O Open an existing title 
    

 Save Title CONTROL + S Save current title 
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  OBJECT LAYERING   

  
   

 Bring to Front CONTROL + SHIFT + ] Bring selected object to front 
    

 Bring Forward CONTROL + ] Bring selected object forward 1 
level 

    

 
Send 
Backward CONTROL + [ Send selected object back 1 level 

    

 Send to Back CONTROL + SHIFT + [ Send selected object to back 
 
It is important to realize these layering controls work within a single layer.  If there are 
other layers present in your title, bring to front will indeed bring the object to the front of 
the objects on that layer, but it may still be covered by objects on a higher layer.  
Changing layer order may also be required to achieve your desired result.  
 
 
 
 
 

 GROUPING   

  
   

 Group Objects CONTROL + G Group selected objects 
    

 
Ungroup 
Objects CONTROL + SHIFT + G Ungroup selected objects 

 
When several objects are grouped you can apply transforms and other changes to 
multiple objects at once.  It is possible to still select a single object in a group: 
 

► ALT + CLICK on an object in a group with the edit tool to 
select this single object only.  
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 LOCK   

   
  

 Lock Objects  Lock selected objects 
    

 
Unlcok 
Objects  Unlock Selected objects 

 
A locked object cannot be moved or rotated, but other attributes may be changed.  
 
 
 
 
 

 

FRAME POSITION   

   
  

 Position  
Objects 

NUMERIC 
Keypad: 
 

7 8 9 
4 5 6 
1 2 3 

Position bounding box of selected item to specific 
position in frame. Note this is NOT the same as 
justifying multiple lines of text – if multiple items 
are selected they will be moved to the same 
position on the screen, overlapping.  
 
These buttons are usually used in the FRONT 
view, as discussed later.  When used in other views 
(Top for example) they take this view into account 
and adjust the Z position (position in 3D space) of 
the object. 
 
If Safe Title is ON, alignment is relative to safe 
title.  If Safe Title is OFF, alignment is relative to 
the frame edges.  
 
Rotated and Extruded objects use the front face as 
the reference for positioning. 
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ALIGNMENT This tool aligns multiple selected objects 
relative to each other.     

   
   

     

  Align TOP   
     

  
Align 
MIDDLE   

     

  
Align 
BOTTOM   

     

  Align LEFT   
     

  
Align 
MIDDLE   

     

  
Align 
RIGHT   

 
The Reference Object 
 
Select all the objects to be aligned.  One of these objects needs to act as a reference object 
– for example if you are left justifying objects, which object do you want all the others to 
adjust to?  Shift + Click on the object to act as the reference.  The reference object can be 
identified by the solid red bounding box handles around it.  All other objects had hollow 
red handles.  
 
 
 
 



Marquee Training Course      Paul Sampson     2007     page  69 

 
 

 

DISTRIBUTION 
Select multiple objects and press 
appropriate button.  Objects will be evenly 
distributed as indicated by button icon. 

   
 

   

 
Distribute HORIZ  
with even gaps  

   

 
Distribute VERT 
with even gaps  

   

 
Distribute DIAG 
with even gaps 

For diagonal distribution, select objects in order, first to 
last 

   

 
Distribute HORIZ 
by left edge  

   

 
Distribute HORIZ 
by midpoint  

   

 
Distribute HORIZ 
by right edge  

   

 
Distribute VERT 
by top edge  

   

 
Distribute VERT 
by middle  

   

 
Distribute VERT 
by right edge  

 
 
Selecting the Reference for Alignment 
 
Normally, objects are distributed relative to each other.  The two objects at the outside 
edges are the reference objects, and the objects in the middle are moved as appropriate.  
 
To distribute objects relative to the container itself – such as the frame - hold CONTROL 
as you click on one of these buttons. The free space will be evenly distributed between 
the objects, and also between the edges of the container itself.  
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Views matter 
 
These keys work differently depending on which view you have selected when you use 
them. Alignments are made along the following axis in the indicated view: 
 

Front View: X  and  Y 
Side View:  Y  and  Z 
Top View X  and  Z 
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 LAYER VIEW 

Shows desired view of currently 
selected layer.  Objects on other 
layers are hidden. Notice shortcut 
keys on numeric keypad logically 
‘match’ the view they select.  

 

   
  

 SCENE CONTROL + NumPad 5 
Shows all objects in the scene, on all 
layers, as they will be rendered in the 
final output.  

    

 LEFT CONTROL + NumPad 4  
    

 FRONT CONTROL + NumPad 2 

This front view displays a GRID so 
you don’t confuse it with the SCENE 
view. The grid indicates you are only 
seeing a single layer. 

    

 RIGHT CONTROL + NumPad 6  
    

 TOP CONTROL + NumPad 8  
    

 
Reset 
Scene  

This button is located at the very 
bottom right of the Monitor Window.   
Clicking on it also shows the entire 
scene from the front, but in addition it 
also executes a Zoom To Fit so you 
always see the entire title filling the 
available window space.  

 
Here are some examples of VIEWS accessible with these buttons: 
 

 
   

     Scene View 
 
Shows the scene as it will appear in 
the Media Composer for the 
audience to see. 
 

     Front View 
 
Notice the grid which indicates this 
is FRONT and not SCENE view.  

     Top View 
 
This shows the current title from the 
top of the stage. Light gray lines 
indicate  X, Y and Z co-ordinates 
for reference during 3D orientation. 
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Views and Tumble vs Rotate 
 
The ROTATE tool actually changes the orientation of an object in 3D space, changing 
the way it looks for the audience. By comparison, the various VIEWS and TUMBLE do 
not change what the audience will see, they only change what the editor sees so we may 
explore and analyze the relationship between objects in our scene.  
 
The preset TOP view and other side views are excellent for getting your bearings when 
you are working in a 3D world. For example, here is what a title looks like from the top 
when we begin to change its position and rotation: 
 
 

   

Top view with title in default position Top view, title moved forward on Z 
Axis (closer to camera) 

Top View, title now tumbled in X 
and Y as well 

 
 
 
 
 
 

Exercise 4 
 

• Students will create a graphic which is a list of names.  This list 
will be left justified, and equally spaced on the screen. 

• Draw a rectangular shape, and place it behind the text 
• Edit this shape to create a less obvious rectangle 
• Adjust the opacity of the shape to make it transparent 
• Use the Transform Palette to ‘scrub’ the lettering forward in Z, 

closer to the ‘camera’ 
• Tumble your scene to see the relationshipo of the objects 
• Use the VIEW buttons to view your scene from several pre-set 

positions in space 
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Module 5: Property Viewers 

 
Objectives: 
 
In this module we will: 
 

• Learn what a property viewer is 
• See how to manage property viewers 
• Learn how to use the Transform, Info and Text property viewers 
• Explore how to work with layers, including using the Layers 

property viewer 
 

Managing Property Viewers 
 
What is a Property Viewer? 
 
Property viewers are extra windows you can open 
to access more controls for various parameters. 
For example, while you can create a shadow with 
Quick Titles, it does not allow access to all the 
Shadow options.  For this, you need to use the 
Shadow Property viewer.  Similarly, there are 
property viewers for: 
 

 Info 
 Text 
 Transform 
 Effect 
 Surfaces 
 Shadow 
 Render 
 Light 
 Path 
 DVE 
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Opening a Property Viewer 
 
We are going to look at some of these viewers here.  As shown above, they can be 
opened from the WINDOW > PROPERTIES menu item. Another way is to simply right 
click on almost any of the other tabs already visible in Marquee to see a list of all the 
property viewers, and chose the one you want from here.  The added benefit is that this 
new viewer opens as a tab in the viewer you used to access it.  
 
 
Closing a Property Viewer 
 
If a property viewer is visible as a stand alone palette (no other tabs nested within it) 
simply click the close box on the property viewer.  If the property viewer shares a 
window with other palettes which you don’t necessarily want to close, you may close one 
of a group of property viewers by right clicking on the tab.  This will call up the list of 
Property viewers mentioned above, but at the bottom of this list is the option to close the 
currently selected tab. 
 
 
 

The Transform Property Viewer 
 
This is one of the most valuable property 
viewers. For a selected object it operates as a 
status viewer- we can look here to read the 
values of the current position, scale, rotation 
and Anchor Point. 
 
We can also change these properties for one 
– or multiple selected objects. Changes may 
be entered by typing a new value in the 
appropriate number field or by dragging on 
the spinners beside each number.  Also, we 
may reset any value to its default by clicking 
on the reset square beside each value.  

 
 

 

Shuttle values           
Reset values             
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Position 
 
This of course indicates the location of an object within the marquee stage. The origin is 
at the screen centre, location 0:0.  The other corners of the frame have numbers which 
depend on the aspect ratio of the frame itself – the upper left corner of course has a 
different ‘location’ in a 4:3 frame than in a 16:9 frame. For NTSC, the screen position 
values in pixels are: 
 

UL – 364.5, 243   TOP Mid 0, 243 
 

UR 364.5, 243 
 

ML -364.5, 0 

 
 
 
 

MR 364.5, 0 

LL – 364.5, -243 Bottom Mid 0, -243 LR 364.5, -243 
 
   
  
Changing frame size 
 
Marquee remembers screen positions as proportions of screen height. If you change a 
frame from a SD frame to an HD frame nothing distorts.  The objects are scaled up to fill 
the larger frame, and retain their relative positions within this larger frame, with the extra 
wide screen space appearing as empty space off either end of the frame.  
 
 
 
Change frame aspect ratio 
 
 If you change the aspect ratio of the frame from 4:3 to 16:9 nothing becomes distorted in 
Marquee- the objects retain their proportionate spacing in the frame. In this case the 
objects fill the centre of the 16:9 frame and the extra space appears as wings on either 
side of the title frame.  
 
 
 
The Anchor Point 
 
We saw how to change the Anchor Point with the rotation tool, and we see it can also be 
changed (and reset) here in the Transform property viewer.  But what is the anchor point? 
 
It is the ‘centre’ of the object, or more accurately the origin around which transforms 
occur.  For example, scaling and rotation use the anchor point as the reference for their 
operations. 
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To swing a title as if it were hinged like a door, we would move the Anchor point outside 
the text and perform a Y rotation.  To scale a font from a particular letter we would place 
the anchor point on that letter before we scale.  Note that changing font size does not use 
the Anchor point as a reference, but scaling (or rotating) the text container does. 
 
 
 
 
 

Info Property Viewer 
 
If you look at the Transform Property 
viewer above, you see a lot of controls 
but not one for controlling the 
dimensions of the selected object. For 
some objects, the Info property viewer 
has those controls. The numbers at the 
bottom of this property viewer adjust 
the size of the selected container. They 
are not used to set sizes of objects, but 
set the size of the bounding boxes that 
contain other objects. This includes the 
bounding boxes of Groups and Text 
Boxes. 
 
Also notice the NAME and COMMENT fields.  Objects can be named, and these names 
are visible in the Layers viewer.  Also, comments can be attached to each object if 
desired.  These could be instructions or design specifications. 
 
 
 
 
 

The Text Property Viewer 
 
This viewer contains settings already 
seen on the Toolbars- Font, Size and 
Kerning.  We also have three new 
controls here. 
 
Scroll Position is used with Rolls and 
Crawls to set the position of the roll or 
crawl. 
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Top Margin    adjusts the position of text up or down within the text box. It can be used to 
raise and lower text, much as baseline shift might be used in many other products.  
 
Bottom Margin   is for rolling text only. It acts as a crop on the text starting at the bottom 
of the text box. You would use it to chose the position on screen you wish the scroll to 
begin at if you don’t want the text to roll on from totally off screen. This setting has not 
effect on static text or crawling text.  
 
 

 

The Layers Property Viewer 
 
We already know the objects you create are placed one on top of the other, and that there 
is a stacking order we can change with the toolbar.  The Layers Property Viewer is a step 
beyond that.  An object may have a stacking order within its own layer, and each layer 
has a stacking order within the title.  
 
One or more objects can be created in a layer so related objects are easier to manage.  For 
example, you might build a complex object on its own layer so you can change its order 
on screen more easily than having to select and move its individual parts within a single 
layer.  
 

  
Layers Palette with two renamed layers visible The layers expanded so details  

about their contents is visible 
 
 
Selecting a Layer 
 

 Click in the Monitor window on any object already on that layer 
 Click on the Layers name in the Layer Property Viewer 

 
The selected layer is the layer in which new objects you create will be placed.  
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Selecting an Object 
 
Even if you can’t see an object because it is off screen, covered by another object or has 
its opacity at 0, you can still select it for modification here in the layers palette.  Click on 
an object in the Layers property viewer to select it.  Shift + click to select a range of 
objects, or Control + click to select (or deselect) individual objects. 
 
 
 
Layer Buttons 
 
When working with layers, there are two buttons which may help you find your way: 
 

 Show or Hide this layer or item. 
 

 Solo this layer or item.  This is useful for finding things which may be hidden as it 
hides everything else! 

 
 
 
 
The Layer Context Menu 
 
 
Right clicking on an object in the layers property viewer 
will access a context menu with all the usual suspects: cut, 
copy, paste, delete, rename and move, which chooses 
object stacking order within the layer.  
 
Layer type allows you to choose 2D or 3D layer behavior. 

 
 
 
Create New Layers 
 
To create a new layer, right click in the layers property viewer.  One of the options is 
“New”, and from there you may choose a new 2D or a new 3D layer to be added to your 
document. 
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2D and 3D layers 
 
A 2D layer ignores 3D behavior.  Layers do not intersect and when attempting to create 
3D, the 2D layer behaves rather badly. This is the default layer type. If you want 3D 
interaction a 2D layer is a bad thing, and a common error.  On the other hand, 2D layers 
behave in a more predictable manner and render more quickly.  If you don’t need 3D 
behavior, you should leave your layers as 2D layers. This might be the case n a complex 
graphic full of 3D objects in which you wish to include some text which should be 
immune from 3D interaction – such as a logo or a bug. 
 
 
 
Navigating layers  
 
Once the layers property viewer is active a layer has been chosen (highlighted) you can 
use your arrow keys to navigate the layers.  
 

• The UP and DOWN arrows move between layers.   
• The LEFT and RIGHT arrows open ad close branches of the layers palette 

 
 
 
Move Objects Between Layers 
 
In the layers property viewer, you can select an object within one layer and drag it to 
another layer.  
 
 
         
Renaming your layer 
 
We saw earlier you can right click on a layer to rename it.  You may also click once on a 
layer to select it.  Pause.  Then click a second time to activate the Layer Name so you can 
retype a new layer name. 
 
 
 
Changing the order of Layers 
 
Click on a layer, or its contents, and drag it to a new position in the layers palette.  You 
may use the multiple select capabilities of your OS to select multiple objects (Shift click 
and Control click). Objects on a top layer cover over objects on a lower layer.   
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Exercise 5 
 
 

• Create a graphic with the text on one layer, and a background 
(drawn) object on a separate later.  

• Use the Transform property viewer to ‘scrub’ the positions of these 
objects in 3D space 

• Use the Layers palette to select the first letter only of your tesx, 
and make this letter larger than the rest 

• Create a second graphic object of a different color, on the same 
layer as the original graphic object 

• Rotate these graphic objects so they (should) intersect 
• Make the layer these graphic objects are on a 3D layer, so they do 

intersect as you expect 
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Module 6: Shadows 
 
 
Shadows are the secret of realism. Shadows create depth and the impression of a 3D 
environment on the 2D TV screen.  
 
 
 
Objectives 
 
At the end of this lesson you will be able to: 
 

• Define the shadow types supported by Marquee 
• Create and manipulate shadows of each type 

 
 
 

We learned how to create a basic drop 
shadow using the Quick Titles window. 
Shadows are much more capable than that 
may have indicated.  We use the Shadows 
Property Viewer to create and manipulate 
shadows with much more control.  
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The Shadow Types 
 
Shadows come in three flavors and can be adjusted using the Shadow Property Window. 
To begin, we need to know what the three types of shadow are. 
 

D
R

O
P 

  
 
Shadow falls behind the object on the 
shadow plane. The shadow is not 
affected by lights in the scene 

 

   

L
O

C
A

L
 

 
 
Shadow falls on shadow plane, and is 
hinged to the edge of each element in 
the original object, ie each letter. 

 

   

PR
O

JE
C

T
E

D
 

  
Shadow is cast from one of the light 
sources in the scene, and will change as 
the light moves. To choose which light, 
open the Shadow Property box and 
choose a light from the “Projected 
From” popup. 
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Shadow Property Viewer settings 

 

 
 

• SHADOW TYPE – Drop, Local or Projected, as described previously 
• PROJECTED FROM - Only works with Projected, selects light that 

casts the shadow 
• X OFFSET and Y OFFSET –Only works with Drop shadows, sets 

shadow position behind object 
• OPACITY – Transparency of  shadow 
• SOFTNESS – Softness of shadow edge 
• SHADOW COLOR – Color of Shadow 
• HINGE SIDE – Where shadow is attached to object-  back, left, right, 

top, bottom. Not relevant for Drop Shadow. 
• HINGE ANGLE – Angle at which shadow is projected onto the plane 

behind the letter. Not relevant for Drop Shadow. 
• HINGE OFFSET – Raises shadow position up and down. Not relevant 

for Drop Shadow. 
• HINGE SKEW – For Local shadows only, tilts shadow left and right. 
• USE MAIN SURFACE ALPHA- makes the shadow take on the shape 

of the alpha channel of an imported image, if it has one, rather than 
casting a shadow from the full rectangle (container) of the image. 

• TEXTURE: You can assign a texture to use as a shadow projection, 
instead of black. We will look at how to assign textures later. To se the 
texture, change your shadow color to WHITE.  Any other shadow 
color will tint the texture, and indeed black will hide the texture 
entirely.  

 
 

Exercise 5 
 

• Create a white background object so you can see your shadows clearly 
• Create and manipulate the three shadow types described here (drop, 

projected and local) 
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Module 7: Lighting 
 
Lights are an extremely powerful 
feature in Marquee. They exist in a full 
3D environment in the sense that 
objects and lights may be positioned 
and animated in X, Y and Z.   
 
They really do create the effect of a 
light shining on an object in space. 
You can use a single light to add depth 
and shading, or create a full ‘scene’ 
with multiple lights distributed in 3D 
space around your objects.  
 
Lights are positioned in space, and as expected lights closer to an object make brighter 
reflections than lights further away.  As well, if you rotate an object the lights will make 
the closer part of the object brighter than the further part.  
 
Lighting must be used to see proper extrusions and edges.  This may be as simple an act 
as checking the ‘Enable Lighting” check box in the Quick Titles window, or can be as 
complex as creating and choreographing multiple lights within the Marquee environment.  
 
Many of the buttons we looked at earlier for centering and alignment also work with 
lights.  To Marquee, lights are just another object! 
 

 
 

No Light 
 

Single, default light turned ON 
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Objectives 
 
At the end of this module you will be able to: 
 

• Active (enable) lights, create and delete lights 
• Describe, select and manipulate lights from the three light types in the Light 

Property Viewer 
• Describe the main mistakes made with lights 

 
 
 

Enabling Lighting 
 

Lighting effects can be added to the 
main surface and / or to the edge.  The 
simplest method is to activate the 
appropriate check box in the Quick 
Titles window. If you are going deeper 
in surface creation, you will be using 
the Surface Properties palette where 
you may also enable or disable 
lighting.   
 
By default, when you enable lighting 
you will have a single white light in 
the left side of your environment (of 
type Local, see next section).  You will 
see the effects of the light, but not the 
light itself.  
 
To see your lights and be able to 
manipulate them, select the Lighting 

button .  You might also like to 
open the Light Properties viewer for 
access to further adjustments (Window 
> Property > Lights).  
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Lights may be positioned in the monitor window 
by dragging them around with the Edit tool.  
Lights have movement in 3 dimensions. To 
access all of these you may need to use 3d views  
and the Transform palette for accurate 
visualization and positioning 
 
Lights may be enabled, disabled, created and 
deleted by right clicking on any light or location 
in the scene and making the appropriate 
selection from the pop-up menu. You may also  
use the following shortcuts with the Light tool: 
 
• New Light:  ALT + CLICK in Monitor 

Window at desired location 
• Delete Light: Select one or more lights and 

press DELETE key on your keyboard 

     
 

 

 
 
 

Light Types 
 
INFINITE 
 
A light like the sun – it casts light that 
comes from far away which is 
directional, and the light rays are 
parallel. Also called a directional 
light.   
 
Note that for this light only, 
increasing the distance does not affect 
brightness unless the light is VERY 
close to the text object. 
 
This light casts hard edge shadows 
which, because the light source is far 
away, do not enlarge behind the 
object, but generally retain the objects 
initial dimensions. 
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LOCAL 
 
A light like a bare bulb or a candle. 
Light is emitted in all directions 
equally.  Also called a point or omni 
directional light. 
 
The shadows can expand (if the light 
is close enough) to become larger 
than the object itself.  

 
 

 
  

SPOT 
 
A light like a true spot light. Light is 
focused in one area and you may 
adjust: 
 
• Spot Target – where the light is 

pointing 
• Size – how focused the light beam 

is 
• Falloff – softness at the edge of 

the shadow 
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Each light may be adjusted using the  
Light Properties Viewer accessed 
through the menu WINDOWS > 
PROPERTIES > LIGHT. Click on a 
light with the Light tool to see the 
attributes for that light. Many aspects 
of each light may be manipulated: 
 
• ENABLE or DISABLE 
• TYPE – Local, Spot or Infinite 
• COLOR 
• INTENSITY 
• POSITION 
• SPOT TARGET – Where the light 

is pointing 
• SPOT SIZE 
• SPOT FALLOFF 
 
Lights are objects in your scene which may also be manipulated and monitored using the 
Transform Property Window.  
 
All aspects of each light may be animated by manipulating their Property Curves in the 
Timeline Window, covered later.  You must select LIGHTS from the VIEW menu in the 
timeline to see the attributes for the lights in your scene.  
 
 
 

Common Mistakes with Lighting 
 
Lighting must be turned on for each object in the scene by choosing enable lighting for 
the main surface (fill) or the border (edge).  
 

► Remember to turn lighting on for all edges or the edge effects will not be 
visible 

 
► Remember in most cases to turn the lighting on for the fill as well as the edges 
for a uniform look 
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EXERCISE 7 
 
Create a circle using 
the drawing tools.  
Add three lights to 
the scene.  Adjust 
each to be one of the 
primary colors- Red, 
Green or Blue. 
Position and point the 
lights at the white 
circle as shown here, 
to create the effect of 
a color wheel.  
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Module 8: Surfaces 
 

Introduction 
 
Marquee allows the use of graphic images in several contexts.  You can use a graphic as a 
texture, for example to fill letters.  You can also use a graphic as a background (which 
will always fill the frame) or as a standard object within your title which you can resize, 
reposition and otherwise treat as any other object in your title. 
 
Marquee has a special property viewer – the surfaces property viewer – to allow you a lot 
of control over the ‘surfaces’ of the objects you create. Each object you create has several 
surfaces which can each be treated separately.  For example, each surface can be filled 
with a color, a texture, a gradient or even a combination of all three.  Also, each of these 
surfaces can be fine tuned from the Surfaces property viewer much more than the Quick 
Titles allowed.  
 
Once you have fine tuned your surface, you may want to save that ‘look’, or some part of 
it, for re-use.  We will look at how to save and recover different properties in the 
Marquee Libraries  
 
 
 
Objectives: 
 
In this module we will: 
 

• Learn how to use the Surfaces Property viewer to apply materials to our 
objects 

• Learn how to work with Solid Colors, Textures and Gradients 
• Learn how to save and apply various combinations of surface properties in 

our Libraries 
• Learn how to incorporate images into Marquee as Backgrounds and 

imported image objects 
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An object has surfaces 
 
A surface is an area of an object. If you draw a shape, or type a letter, the obvious surface 
is the front of the letter or the shape. This is the Main surface, but there are several others 
associated with every object you create.  
 

• MAIN SURFACE: The front of the objects 
• The EDGE: The surface created by the edge effect on the object 
• The EXTRUSION: Surface created by the extruded sides of the object 
• The BACKGROUND: The area behind the text, which in the case of font is 

sized by the text container 
 

 
 
Each of these surfaces can be customized with one or more of these: 
 

• Solid Color 
• Gradient 
• Texture 

 
When a surface is customized with some combination of these, we call the result a 
material. Materials, as we shall see, can be saved in the Materials library and applied to 
other objects.  We use the Surfaces Property viewer to create and modify all our surfaces. 
The Surfaces Property Viewer allows us to customize the surface of the selected 
object(s), or if no object is selected, we can customize the surface of the next object we 
create.  
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Using the Surfaces Property Viewer 
 
Earlier in this course we looked at the how to open and manage property viewers. The 
Surfaces Property viewer is used to adjust the surfaces of an object – its main surface, 
extruded sides, the edge between the two and the background behind the container.  
 
The Surfaces property viewer is 
dominated by the Material Swatch 
graphic. This graphic shows how your 
surface settings will look on different 
objects.  If you right click on the 
Material swatch, you will be able to 
choose four types of swatch: 
 

• Plane 
• Sphere 
• Bevel 
• Sample Object 

 
The selected swatch will be displayed 
with the currently selected Surface 
properties, except the Sample Object 
which shows the three surfaces on its 
shape accurately.  
 
 
Material Swatch Choices 
 

 

Sample Object 
 
Shows all surfaces at 
once, applied to a 3d 
shape 

 

Sphere 
 
Surface applied to a 
sphere, most useful 
when setting lights 
as you can see 
highlights 

    

 

Plane 
 
Shows material 
mapped onto a flat 
surface. 

 

Bevel 
 
Best to see material 
applied to surface 
with an edge 

 
 
 

►   If Lighting is not enabled on a surface, both Sphere and Bevel 
appear as flat objects. 
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Selecting surfaces of you shape 
 
We know that a shape can have up to four separate surface treatments. MAIN, EDGE, 
EXTRUDE and BACKGROUND.  Each of these surfaces has identical controls, as we 
will see in a moment.   We switch between the surfaces we want to change in a number of 
ways: 
 

• Use the Surfaces list box in the Surfaces property viewer 
• Click on the Material Swatch of the Sample Object (shown at 

right). The Sample Object has four segments representing 
each of the objects surfaces A circular front for the MAIN 
surface, a beveled edge for the EDGE, a cylinder for the 
EXTRUSION and a background for the BACKGROUND. 
Click on the desired surface to select its settings.  

 
It is also worth noting that you can drag and drop textures and materials from the library 
onto any one of the surfaces of the Sample Object swatch.  You can also right click on a 
surface of the Sample Object to choose Copy Texture, Copy Material and Paste.  
 
 
 
 
 

SOLID COLOR type Surfaces 
 
Select Solid Color as the type of 
surface.  This is the default if you have 
not selected any surface yet.  
 
Some of the controls are familiar, as 
they were first seen in the Quick Titles 
window. 
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The adjustments available are: 
 

• Master Opacity adjusts the opacity of the entire object 
• Surface allows us to choose other surfaces for customization (more on this 

later).  
• Type is where we select Solid, Gradient or Texture as the fill for this 

surface 
• Enable Surface makes this surface visible 
• Base is the color of the surface.  Even with gradients and textures Base 

will provide a color to the surface. 
• Opacity adjusts the transparency of this surface only 
• Enable Lighting allows lighting to be used on this surface 
• Specular is the color of the specular reflection created by the lights on the 

surface.  It is the color of the lights reflection on the surface. Use the color 
well to assign any color you wish. White (the default) will reflect the light 
in its original color. 

• Emissive is the color the object will emit when no light strikes it surface.  
T si the glow color of the object.  You may set any color as the emissive 
color using the emissive color well.  

• Shininess adjusts how shiny the surface appears when a light strikes t. 0 is 
dull finish (specular highlight area is broad), and a higher number is more 
shiney (specular highlight is smaller).   

• Environment – See below 
• Overlap – see below 

 
 
Environment Map 
 
An Environment Map is a texture which can show up in the highlight areas of a surface. 
It is an enhancement to the basic specular reflection by adding a reflection of the 
surrounding environment to the highlight. You won’t actually see the texture, as a very 
out of focus version of the texture is applied to the surface.  If the object is moving or 
rotating, the environment map will be a little more noticeable.  
 
To apply an environment map, drag and drop a texture from the Texture Library into the 
‘texture well’ to the right of the word ‘Environment’ in the surfaces property viewer. 
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Using Overlap 
 
Usually, two overlapping surfaces do not interact.  You may change this by choosing a 
method of interaction using the Overlap list box.  Overlap effects work best on 2D layers. 
 

      
 

Normal                                         Not-or 
 

 
 

Banner covering bottom of text is Exclusive Or 
 
Be prepared to spend time experimenting if you want to choose one of the alternative 
Overlap modes.  They are: 
 

• Normal 
• Invert 
• And 
• Exclusive Or 
• Not Or 
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TEXTURE type Surfaces 
 
A texture is a graphic image that can be placed into or wrapped around your object.  
 
If you change the surface type to 
Texture, a new panel opens at the 
bottom of the Surfaces Property 
viewer.  To apply a texture: 
 
• Drag it from the Texture library 

and dropping it on the Texture 
Well (to the right of the word 
Texture) 

• Drag and drop a texture on the 
appropriate part of the Material 
Swatch.  

• If you want to apply the texture to 
the main surface, you can simply 
double click on a texture in the 
texture library, or drag and drop it 
onto the object itself in the 
Monitor window. 

 
 
 
Standard Texture Settings 
 

 
 
Tile: Tile OFF is the default, and the texture is stretched to fill the surface (container) to 
which it is applied.   
 
Offset and Scale: If you reposition the texture using the X and Y offset controls, or shrink 
it using the X and Y scale controls, you will see off its edge  Turning TILE on will hide 
the resulting smear by tiling the texture instead of smearing its edge. 
 



AVID Marquee Training       Paul Sampson, TVC, Toronto                   1/1/2007 97

 
 
Texture applied to rectangle, and 
it is stretched to fill the object 

If the tile is repositioned using the 
OFFSET controls or shrunk using 
the Scale controls, you see a 
smear off the edge of the texture 

Activate Tile and the texture will 
repeat and if it is a proper tiling 
texture, the seams will be 
invisible.  

 
Z Rotation rotates the tile inside the object.  
 
Tint applies the currently selected color as a tint on top of the tile.  Select white for no 
extra tint applied.  
 
Mapping has three settings:  Local, Container, Reflection 
 
Local applies the texture to each object in the container, for example that is to each letter 
in a group of letters.  
 
Container applies the texture to all objects in the container as a group, for example it 
applies the texture once across all the letters in a text container 
 
Reflection will blow up the texture, blur it and apply it as if it is being reflected in the 
surface.  The texture applied in this way makes the surface appear metallic.  To see more 
of the texture as a reflection, scale it down.  
 
 
 
Cropping a Texture 
 

 
 
Click the Crop button  to access the Crop Texture Controls. You may crop the top, 
bottom, left or right edges.   You would do this if you only wanted to use part of a 
texture, or in cases where a TV frame grab you might be using as a texture has a black 
‘blanking’ edge. 
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GRADIENT type Surfaces 
 
If you select a Gradient as the surface 
type, a gradient selector area appears 
at the bottom of the Surfaces property 
viewer. This Gradient bar is used 
exactly the same as the one we 
explored in the Quick Titles window.  
It is also possible to use a Gradient 
and all the other Surface settings at the 
same time as a gradient.  

 
 
 

Exercise 8 
 

• Create a background object 
• Add a texture to this surface.  This will be the Background for your 

scene. 
• Create some text.  Extrude the text, add an edge. Place the same 

texture on both the letters and the edge 
• Type a second line of text, and add a texture to it.  In the Properties 

viewer, make this texture a Reflected texture (use the mapping 
drop down menu).  Rotate these letters to see the metallic 
appearance of this reflected texture.  
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Module 9: Libraries 
 
 
The Library windows display the contents on Marquee Libraries in virtual (not actual) 
folders. The contents of many of these folders can be copied, moved, created and deleted.  
Not all folders are editable however- the AVID folders contain elements which will not 
vary from system to system – and that is because you can’t change them.  
 
 
The Five Marquee Libraries 
 
 

TEXTURES Allows access to Graphics files which you can apply to the surface 
of an object. 

  
MATERIALS Properties related in more detail to how an object surface looks.  

These include things like color, opacity, gradient and Texture.  
 
A material stores the settings from a single property viewer: the 
Styles Property viewer 

  
STYLES A style remembers more parameters than a material. It remembers 

an objects settings from several property viewers, including 
Transform, text, container, shadow, surfaces, render, light, path, 
DVE.  A Style can also store animation of these properties.  The 
style does not store the object itself, just many of its properties. 

  
TEMPLATES A Template remembers all the Property attributes, as in a style, but 

also remembers the OBJECTS in the title.  The actual text, lights, 
DVE’s, paths, shapes and so on.  

  
SCRIPTS Macro’s or small programs which may act on the contents of your 

title to create complex behavior with minimal effort.  Other scripts 
actually create titles – such as the Auto Titler script – which creates 
formatted titles automatically from a simple text file. TypeOn is 
another script which will type your text on screen character by 
character.  
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Textures 
 
A texture is a graphic applied as a covering to a surface.  Many textures are supplied in 
Marquee, and you can add your own as well.  To apply a texture to a surface of your 
object: 
 

• Double click on a texture to 
apply it to the main surface of all 
selected objects 
• Drag a texture from the 
library and drop it on the object 
in the Monitor window. This 
applies the texture to the Main 
(front) surface only. 
• Drag a texture from the 
library and drop it on the Texture 
Well of the surface you want to 
apply it to in the Surface 
Properties viewer 
• Drag a texture from the 
library and drop it on the 
surface you want to apply 
it to in the Material Swatch 
graphic of the Surface 
Property viewer 
• Use copy and paste: right 
click on the texture in the Library 
and choose COPY, right click on 
the Material swatch in the 
surfaces prtoperty viewer and 
choose Paste (see right) 

Right Click on Material watch 
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Materials 
 
A Material is a combination of surface properties, as 
listed here in the New Material dialogue. Notice a 
material does not have a ‘face’, that is it is not 
related to the main surface, extrude, bevel or 
background.  It is just, plain and simple, a surface 
defined by its color, opacity and other properties.   
 
Check marks appear in the non-default parameter, 
that is for the parameters which you changed.  You 
can add check marks to the other parameters if you 
wish, and this will ensure they are set to the defaults 
when this material is applied to a surface.  
 
   
 
To save a material:  
 

• Right Click inside the Materials Library and choose New material.  The current 
Main Surface settings will be saved as a material in the library. 

• Copy and Paste: right click on the surface in the Sample Object of the Surface 
Property viewer. Choose COPY.  Right click in the Materials Library and choose 
PASTE.  

 
Materials are applied the same way Textures are: 
 

• Double click on a material to apply it to the main surface of all selected 
objects 

• Drag a material from the library and drop it on the object in the Monitor 
window. This applies the material to the Main (front) surface only. 

• Drag a material from the library and drop it on the surface you want to 
apply it to in the Material Swatch graphic of the Surface Property viewer 

• Use copy and paste: right click on the texture in the Library and choose 
COPY, right click on the Material swatch in the surfaces property viewer 
and choose PASTE  
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To Edit a Material 
 
Right click on a material and chose Edit.  A dialogue 
similar to the New Material box appears.  You may 
add and remove checkmarks, and also in some fields 
actually click on values and type in new ones, as 
shown here with Opacity.  
 
You cannot edit an Avid material, but you can use 
the context menu to copy and paste it into a user or 
site folder where the copy will be editable. 
 

 
 
 
 
 
 

Styles 
 
While a material remembered the settings from one 
property viewer, a style remembers the settings in 
all the property viewers shown below in the New 
Style dialogue box.  It does not remember the 
object itself, but remembers a lot of its attributes.  
 
There are two icon types associated with styles. 
The icon with a blue dot contains animated 
properties, and will be rendered out of Marquee as 
an animation. This takes longer than the creation of 
a non-animated title.  The orange dot effect is, of 
course, this non-animated title which will normally 
render out as a static title in the AVID editing 
system.  
 
You should explore the available styles. There are many pre-built effects for blinking, 
sliding, wiping, rotating, flipping.  You might consider Styles the simplest way to apply a 
(preset) animation to your objects! 
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Saving a Style 
 

• Select the object from which you wish to 
create the style, then right click inside the 
Styles Library and choose New Style.  The 
current settings will be saved as a style in the 
library. 

 
As before, any non-default values appear already 
checked.  You can add check marks to lock extra 
default parameters in.  You may wish to deselect 
some parameters if you don’t want to change these 
attributes for the objects which are the target of the 
style.  For example, uncheck Transform so when you 
apply the style you do not change the objects size, 
position and rotation. 

 

 
If a property is animated it will appear as italicized text in this dialogue.  
 
 
 
Applying a Style 
 

• Double click on a style to apply it all selected objects 
• Drag a style from the library and drop it on the object in the Monitor 

window.  
 
 
 
Editing a Style: Basic changes 
 
Right click on a style and choose Edit.  The Edit 
Style dialogue appears, and it is used essentially 
the same way the Edit Material dialogue is.  You 
may add and remove checkmarks, and also in 
some fields actually click on values and type in 
new ones, as shown here with Opacity.  Fields 
who’s names are italicized indicate parameters 
which are animated.  Normally, do not change 
these values here directly.  
 
You cannot edit an Avid style, but you can use the 
context menu to copy and paste it into a user or 
site folder where the copy will be editable. 

 
 
 
Editing a Style: More advanced changes 
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If you want to change parameters that cannot be accessed through Edit Style, you can 
apply the style being altered to a dummy object, change the parameters, and re-save the 
style with the new settings.  
 
 
 
 

Templates 
 
A template remembers all the property viewer settings, as in a style, but also remembers 
the nature of the objects themselves and their environment.  A template contains the 
actual text or shapes, along with their attributes.  As well, they can remember the 
environment in which the objects live – the lights for example.  
 
When a template is added to a title all its objects are added to whatever is already there.  
They do not replace or remove objects already in the title.  A result of this is that you can 
apply more than one template at a time to a title.  
 
Templates are useful for saving standard title formats, for example lower third supers.  
But this is only the most obvious example.  Templates can contain backgrounds, rolls or 
crawls with most names and logo’s already in place, weather maps with libraries of 
symbols and completed opening animations.  You owe it to yourself to explore the library 
of AVID templates to get a better idea of the scope of what is possible Also, remember 
you can copy and paste a template into a user or site folder where you can modify it for 
your own use! 
 
 
 
Saving a Template 
 
• Create the title which is to become the 

template 
• Lock objects in the title if appropriate 

to protect the templates integrity when 
it is used.  

• Select these objects which are to be part 
of the template. 

• In the Template library, right click in 
the folder in which you want to store 
the template.  You cannot add (or 
delete) to the AVID folder. Save As 
Template appears (right) 

• Type a name and press OK 
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Apply a Template 
 

• Create or open the target title 
• In the Template library, double click on the name of the template 

you wish to use. 
 
The objects of the template are added to the title complete with all their objects,  
properties and animations.  
 
 
 
 
 

Scripts 
 
A script is an automated process you can apply to a 
title, or to an object in a title.  Scripts come with 
your Avid editing product, and new ones need to 
be developed by Python programmers.  In most 
cases, you will only have access to the AVID 
supplied scripts, and the other folders (User, Site) 
will remain empty.  
 
Some scripts fade objects up or down, fly objects 
on or off the screen,  delete or move keyframes, 
type characters onto the screen or even make new 
tiles from a text file!  
 
 
Learning about a script 
 
If you single click on a script name in the script window, text appears at the bottom of the 
script window telling you what this script does, and how to setup to run it.  
 
 
Applying a Script 
 

• Since most scripts are designed to modify objects, we often begin by 
selecting one or more objects in the monitor window or the layers 
viewer 

• Double click on the scripts name in the Script library 
 
 
 



AVID Marquee Training       Paul Sampson, TVC, Toronto                   1/1/2007 106

Running Autotitler 
 
Probably the most used script is AutoTitler.  This creates a number of titles from a plain 
text file. You create a master title, create a text file with all the supers typed out, and run 
the script to convert the text file into numerous individual titles. A common application 
of course is for the creation of lower third titles – or ‘name straps’. 
 

• Create the master title, the one you will be duplicating.  Add and style 
some text in this file so the title looks like the final version you want. 
The text you type is of no consequence, it will be replaced. You might 
like to save it as a template for future use. 

• Name the text fields in your title “Text Box 1”; “Text Box 2” and so 
on.  Text Box 1 text field will get the first line of text from the ascii 
file, Text Box 2 will get the second line of text from the ascii file, and 
so on.  Text fields are named in the Info property viewer (Window > 
Properties > Info). 

• Prepare a plain text, ascii text file with the supers in it.  Place each line 
of the super on a separate line in the text file, and separate titles by a 
blank line. No Unicode allowed. 

• With the reference title open, double click on the ‘AutoTitler” script in 
the Script window.  A dialogue will ask you to choose the text file you 
want to use. Your titles will be created. 

• If your text file has too many items for the available text fields, an 
error message appears, and then you may choose to let the script 
continue or stop. 

• If your text file has too few items for the available text fields the 
original text in the sample title will be placed in the field.  If the 
original text fields were blank, then the (empty) text fields will be 
blank also.  This allows you to create titles with multiple fields when 
you may have differing numbers of entries to make on each title.  

• The created titles can be reviewed, and then saved if desired. Save All 
To Bin from the file menu might be useful in these circumstances. 

 
 
On older Avid systems, AutoTitler was a script.  Now, on the newer systems it appears as 
a menu item under FILE.  On newer Avids then, follow the above instructions and then 
select FILE > AUTOTITLER to run the ‘macro’.  
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Inside the Libraries: Library Folders 
 
 
While we have been working with Library windows, it is now time to look more closely 
at their structure.  
 
Each library has a folder structure that is organizational, and does not reflect where files 
are actually stored on your hard drive.  
 
 

AVID 
 

Library elements in this folder are supplied by AVID, are read only, and 
cannot be modified.  Anything you use from these folders will be available on 
any AVID of the same type and version.  You may Copy and Paste these items 
into other folders so they can be modified. 

  
User  

 
These folders contain objects saved here by the current user. On your hard 
drive, they will be placed inside the Avid User folder under the name of the 
current user.  In other word, they are conveniently placed in the AVID USER 
folder with the users other settings. The folder itself is named 
MarqueeUserFiles. Use these folders for your personal settings which you do 
not intent to share with other users. 
 
If you do want to share or move these settings, simply move this entire folder 
into the User Settings of another user or into your user settings on another 
system.  All your User folders from Marquee will then be available on that 
system. 

  
Site 

 
These Library elements are available to all users on the system, and you should 
store elements here that multiple users will need to access.  Elements you place 
here are stored in a folder in the same directory Marquee is installed in.   

  
Title 

 
Items in this folder are visible / saved as part of the title itself. They are only 
available when the title is opened in Marquee.  They are not visible when 
working on other titles, and so do not continually appear, and possible clutter 
up, your Library display.  Also note that elements in this folder can be in 
various directories on your hard drive.  For example, if you use an image in 
your title it will appear here (under textures). The original file (wherever it is 
located) is being used, a copy has not been made or moved into some other 
location. The image is also not stored as an actual part of the title.  
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Saving and applying Library Elements 
 
 
Adding to a Library 
 

• Select the reference object from which you want to create the library entry 
• In the Library window, click on the tab for the element you wish to save- texture, 

style, material or template, as described previously. We will use the ‘Material’ 
folder in this description. 

• Right click on the folder in which you would like to save this library item.  
• Chose ‘NEW’ from the context menu 
• Place checkmarks into the checkboxes beside the attributes you wish this material 

to save.   
• Click “OK” to save this material 

 
If you leave something unchecked, its attributes will not be saved as part of the library.  
This is actually very useful.  You can save main surface colors without changing other 
properties, for example.  
 
 
 
COPY or MOVE Library Element 
 

• Right Click on the source element to access its context menu 
• Choose CUT (to move) or COPY (to copy) the element 
• Right click on the destination folder 
• Choose PASTE from the context menu 

 
You may copy from, but not into, the AVID folder.  As well, you cannot MOVE (use 
CUT) within the AVID folder 
 
 
 
Rename a folder or element 
 

• Right Click on a folder or an element to access its context menu 
• Choose Rename 
• Type in a new name 

 
You cannot rename the AVID folder or its contents.  
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Delete a folder or element 
 
 

• Right Click on a folder or an element to access its context menu 
• Choose Delete 

 
The item is deleted immediately.  You cannot delete from the AVID folder. 
 
 
 
 
 

Promoting Title Tool Styles to Marquee 
 
Now that you know what a style is, you might have some title tool styles you want to use 
in Marquee. This can be accomplished by Promoting Title Tool styles to Marquee, either 
all at once or one at a time.  Promoted Title Tool styles are saved as Marquee User styles, 
and does not delete or change the original styles from which they came.  
 
 
 
Convert All Title Tool Styles 
 
This is a time limited offer. The first time you start Marquee, and until you save any 
style, texture or material, you will be asked if you want to convert all your styles.  Choose 
yes to do so.  Once this dialogue is gone, it cannot be called up again.  You can still 
convert Title Tool styles one by one.  
 
 
 
Converting Individual Title Tool Styles to Marquee 
 

• From the Settings tab of the project window, find the name of the style 
you wish to convert.   

• Double click on the style name 
• Click on the “Convert To Marquee” button at the bottom of the style sheet. 

 
If the style already exists in Marquee, you will see a dialogue box in which you can 
choose to cancel, overwrite the existing marquee version or allow multiple versions with 
the same name.  
 
 
 
 
Some warnings: 
 

• Only True Type fonts will convert to the same font in Marquee.  Other 
fonts will use the marquee default font. 
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• Bold and Italics will only convert if a Bold or Italics version of the font is 
present.  The BOLD and ITALICS buttons in the Title tool have no 
equivalent in Marquee 

• Small adjustments of Kerning, shadows, borders, corners, gradients may 
be required. 

 
 
 
 

Adding Graphics to your Marquee Title 
 
The Default Background 
 
By default, Marquee shows you the frame you parked on in the editing application as a 
background.  This is for reference only, and does not become part of your title. You can 
click on the Background button to hide this image, if it is interfering with your 
observation of the title.  You can change the background image buy returning to your 
editing application and changing the park position of the recorder.  
 
 
 
Graphic As An Imported Background 
 
A graphic image may be imported as a background.  It will be clipped to the frame (if too 
large) or padded out with black (if too small).  If there is an Alpha channel, it will be used 
in Marquee and only the appropriate portions of the image will be visible. 
 
Imported backgrounds cannot be moved, scaled or positioned.  They are centered on the 
frame, and are rendered out as part of your title. 
 

• To add a background, chose FILE > IMPORT > BACKGROUND 
• To remove a background, choose EDIT > CLEAR BACKGROUND 

 
 
 
Import Graphic as an Image 
 
If you wish to import a graphic to use as part of your title, rather than as a background, 
you can import it as an Image.  An Image is treated as any other Marquee object is.  In 
fact, if you wish you can select your image and apply a main surface color to it to tint the 
image.  Images appear in the bottom of your Textures Palette. The Image file however is 
not copied to an .mqp file, neither is it copied into any folder within the AVID editing 
application.  You may need to manually ensure the image file is available for future 
versions of this title.   
 

• To import an Image, choose FILE > IMPORT > IMAGE 
 
 



AVID Marquee Training       Paul Sampson, TVC, Toronto                   1/1/2007 111

 

EXERCISE 9 
 

• Create a title with at least a gradient in one line, an edge and a 
shadow. 

• Save this “look’ for later re-use.  Save it as a Material.  Save the 
same thing as a Style.  Save it as a Template. Note the difference in 
what is saved in each case. 
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Module 10: The DVE 
 
Many of us know “DVE’ as a generic term for Digital Video Effect, as created by an 
older generation of digital video effects equipment in linear edit suites.  This is not that 
DVE!   
 
This DVE is an objects which you can deform into spheres, page curls and ripples. You 
can twist them, texture them, position them and light them in 3D space.  
 

      
 

Sphere DVE with texture map of 
the Earth applied 

Rippled DVE with lights to  
create a background 

 
For a true 3D effect, you will of course need to enable lighting for the DVE. 
 
 
Creating a DVE 
 
• From the Object menu, chose 

Create DVE. A full screen sized 
rectangle appears in your title.  

• Open the DVE Properties viewer 
(Window > Properties > DVE) and 
choose the type of DVE you want, 
and its parameters.  

 

 
 
 
 
 
 
DVE Types (Effects) 
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From the top of the DVE Property viewer you may choose what shape you want this 
DVE to be. The choices are: 
 

Border 
 

 
  

Places a colored frame around the image. The frame takes away part of the image.  Frame 
width, color and softness are adjustable. 

  

Default 
 

 
  

The default is a rectangular surface the size of your title frame.  
  

Page Curl 
 

 
  

Curls the page like a page in a book, revealing the back surface. Radius is the tightness of 
the curve, angle is position of the curl on the surface. And curl time is amount of the 
curve.  Curl time is what you would animate to completely curl the page on or off the 
screen.  
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Ripple 
 

 
  

Ripple creates parallel waves across the surface.  The number, angle and height of the 
waves is adjustable.  Amplitude is wave height, Angle is angle of the wave on the DVE, 
Ripple Time is what you would animate to move the wave across the surface, and 
frequence controls the number of waves present.  

  

Sphere 
 

 
  

Sphere creates a sphere or a cylinder, depending on the settings.  This is the oddest DVE 
with the most variations, some rather odd! Angle and distortion are the two controls you 
want to explore to get the most out of this shape. 
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Adding a Displacement Map to a DVE 
 
You may use a texture to add bumps or texture to the DVE surface.  The texture you use 
has its light and dark tones translated into lowered and raised portions of the DVE 
surface.  The alpha channel of the graphic has no effect on the displacement map.  
 

 
 

A Texture – Rivets – applied as a displacement map (top, and settings in DVE Property viewer)  
and a standard DVE without the displacement map (bottom) 

 
When using a displacement map, pay particular attention to the Displacement settings, 
and the Detail adjustments.  Detail will bring the texture into ‘focus’ at its maximum 
setting of 10.  At the default setting of 1.00, your texture will be visible, but hardly 
recognizable as it will be so averaged out.  
 
 
 
 

EXERCISE 10 
 

• Create a Sphere using the DVE. 
• Place two or three lights around your sphere to clearly show its shape 
• Import a texture of the earth to your Textures folder 
• Add a texture of the earth to your sphere.  
• Save this as a Template 

 



AVID Marquee Training       Paul Sampson, TVC, Toronto                   1/1/2007 116

Module 11: Rolls, Crawls, Path Text 
 
 
Introduction 
 
This module is about moving font within Marquee.  Specifically, we will look at Rolls, 
Crawls and Path Text.  
 
Creating these three types of text is easy.  What may not be obvious is what is going on 
behind the scenes.  To really master these types of text, you need to understand the 
different types of Marquee titles, and how Marquee sets – or doesn’t set – the title 
durations.  Specifically, we will explore in this module: 
 

• The four Marquee title types: Static Title, Roll, Crawl, 
Animated titles 

• Setting Marquee Durations in the FILE > PREFERENCES and 
FILE> DURATION dialogues 

• Creating Rolls 
• Creating Crawls 
• Creating Path Text 

 
 
 
 
 

The Four Title Types 
 
 
Text Types 
 
A static title doesn’t move. In the Avid world, this also means nothing else moves.  Not a 
letter, not a shadow, not a light. 
 
Rolls are the standard method of presenting credits at the end of a program, where the 
credits start off screen and then move from the bottom to the top of the screen.   
 
Crawls are where the titles move across the bottom of the screen, usually from right to 
left, and usually a single line tall at a time.   
 
Path Text is where text is not typed in a straight line, but is attached to a shape created 
by the editor  This shape can be a square, circle or any path drawn using the pen tool.  
Once the type is placed on a Path, it can be moved along that path by making it a crawl. 
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STATIC Title 
 
A static title is a single frame of non-moving text. It is also a frame in which there are no 
moving lights or other objects. Because everything is static, when this title is saved to 
your bin, Marquee creates a single static image. This image appears in the bin as a 2 
minute long title. There is no control in Marquee over his duration.  The static title 
renders very quickly, plays as a real time effect and is similar to a title from the regular 
Title tool.  
 
 
ANIMATED title 
 
This is a title in which there is movement.  There may be movement of the title text or 
other objects in the frame.  There may be moving lights or shadows. In any case, this 
results in change occurring from frame to frame. As a result, Marquee needs to render 
every frame of the animation, not just a single frame. This of course takes longer, and the 
result is actually a movie. This movie – animated title – appears in your bin at a specific 
duration and as a real time matte key. The duration of the title in this case is controlled in 
Marquee, it cannot be changed by trimming in the timeline, as with a regular title.  
 
 
ROLL title 
 
A roll is a title in which the text moves (usually) from the bottom of the screen to the top 
of the screen.  If certain criteria are met, this title can be created internally as a group of 
static ‘cards’ that are simply scrolled up the screen.  In this case, only a few frames need 
to be rendered. Marquee places the final title in the bin at a duration that varies with the 
number of screens of text.  It allows 1 minute per screen. 
 
You can preview the Roll in Marquee at a Duration you set in Marquee. In this case the 
Marquee duration does not effect the length of the final roll.  That is controlled by how 
much of the title you edit into your timeline in the editing application, and where you 
may place scroll keyframes there.  
 
If the Roll is not simple, it may need to be rendered as an animation. If there are lights, 
other objects, clipped edges or one of several other conditions, the title changes frame by 
frame and again Marquee must render out each and every frame. We say this is no longer 
an Avid Rolling Title, but an Animation. It will be rendered as a real time matte key. 
 
 
CRAWLING title 
 
This is handled the same as a rolling title.  If it is simple and meets certain criteria, it is 
called an Avid Crawling Title and is made up of several single frames of font which the 
avid slides across the frame. The duration set in Marquee is for preview only, the on-
screen duration is controlled by how you edit and manipulate this crawl in the timeline. If 
you add lights, other objects and otherwise fail to meet the criteria for an Avid Crawling 
Title, it will be rendered out frame by frame into an animation.  In this case the duration 
of the animation does match the Marquee duration.  
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PATH TEXT title 
 
If you type text onto a line or shape, we have text applied to a path. If the text does not 
move – if it is static text – then the title is rendered as a single frame and we have 
essentially a Static title as described above.  
 
Text on a path can be designated as a Crawl then this text can be animated along the path.  
Now every frame must be rendered, and once again we are looking at rendering the title 
as an Animation.  This takes longer, and the duration of the title is once again determined 
by the Marquee duration.   
 
 
 
Avid Rolls, Avid Crawls and Animated Titles 
 
Rolls and Crawls can be saved internally as a series of static images which are scrolled 
across the frame. This is possible if they meet certain specific requirements. For example 
the title must fill the height (Roll) or the Width (Crawl) of the frame, have a single text 
object, contain no other objects of any kind, move at a uniform speed, text object is not 
animated except for the crawl or roll). This type of   Roll or Crawl will behave in the 
Avid editing application the same as a roll or crawl from the original Title tool, and will 
be able to have its duration modified and parameters edited in a simple manner.  It will 
also be a real time effect in the editing application. Titles of this type are called Avid 
Rolling Titles or Avid Crawling Titles.  
 
Their length (in time) is a minute per ‘page’, which is why Rolls and Crawls seem to 
come up at various random durations in the editing program. The Duration set in 
Marquee in this case is for previews only, and has no impact on the duration the title will 
be when saved into the editing application.  
 
If the Title or Crawl has certain attributes, such as lights, changes in scale or rotation, it 
cannot be portrayed internally as a series of static frames and needs to be rendered out as 
a movie instead.  
 
For example, if you have a light on in a Roll the lights effects changes with every frame, 
then every frame of the title will be different as the title moves, and now in effect 
Marquee will need to render out not a single frame, but a separate frame for every bit of 
your title.  Marquee must render the title as a movie. 
 
This is what we call an Animated title, and it takes longer to render.  It is passed back to 
the Avid editor as a real time moving matte movie. This type of title is called an 
Animated Title to reflect the fact that it is an entirely rendered movie. As such, changing 
the roll duration usually requires a complete re-rendering of the animation. When you 
need them, this may be a small price to pay for the inclusion of lights, moving textures 
and other sophisticated effects in a title roll or crawl.  
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The length of an Animated title is rendered out at is the duration of the title in Marquee.  
How do we set this?  Glad you asked…. 
 
 
 
 

Setting Title Durations in Marquee 
 
Marquee has three places where duration can be set: 
 

FILE > PREFERENCES  > CURRENT 
TITLE 

 
  

FILE > DURATION 

 
  

Right click in the Time Display area and 
choose Duration from the popup menu: 
 

 
 
 
For Static, Avid Rolling Titles and Avid Crawling titles, the durations are for previews 
only. They do not determine the final length of your title.  You will do that in your 
editing application. 
 
For Animated titles, this duration will determine the length of your animation, and thus 
the length of your title.  
 
When you change the duration, all the moves on your title scale to the new duration.  
Changing the duration of a title will never clip any movement, or add dead space at the 
end of your title.  Everything scales to fill the new duration.  
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Rolling Titles 
 
 
Creating a Rolling Title 
 
A roll may begin by typing text on the screen in the normal way, and then designating the 
frame as a Roll.  If you are taking this approach, a text field can be designated as a 
Rolling text field or a Crawling text field by right clicking within your text with the text 
tool, and choosing MOTION > ROLL or MOTION>  CRAWL.  
 
If you know you want rolling text title before you begin, there are faster ways.  For 
example, simply click the ROLL button in the Toolbox.  This creates the text field, and 
designates it as a roll for you. The text field is also perfectly proportioned – it is the full 
height of the frame, and the left and right edges are adjusted to TV safe.  
 
If a text field is already present and has been selected, you may also click on the ROLL 
button to make the height of the text field fill the frame without changing its width.  
 
A second automated way is to use the Rolling Title Template- simply open the Template 
library and double click on the rolling template you wish to use.  
 
 

    
 

Empty Text field for a roll, ready to 
Type in the text 

Roll text field with text entered.  If there is 
more text than screen space a scroll bar 
appears and the font scrolls off the screen.  

 
 
 
The Rolling Font disappears- scrolling through the Roll 
 
When you choose the EDIT tool, your text disappears. This is because Marquee is setting 
your roll up at its start position, where all the text is off screen. To see your text again, 
choose the TEXT tool and click on your text object. The text, along with the scroll bars, 
reappears.  
 
There is another way to see your text. A roll or a crawl in Marquee has duration – by 
default 5 seconds.  If you scroll through the Marquee ‘timeline’ you will see the Roll 
occurring.   
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To do this, click and drag back and forth on the time code 
number at the lower right of the Monitor window.  Hold 
CONTROL to scroll more slowly. Hold SHIFT to scroll 
more quickly 
 
 
 
Setting the Roll Duration 
 
To change the duration of any animated title, 
choose FILE > DURATION and enter the 
new, desired duration. Any animation you 
had is now rescaled to fill the new duration.  
No part of your movement will ever be 
clipped, and no pauses or holds will be added 
at the end of your animation using this 
Duration feature.  

 

 
If your title is not an animated title, the duration you enter here will be used in Marquee 
for previews, but will not determine the final length of your title.  
 
 
 
Setting the Roll Scroll position 
 
Normally a Roll or Crawl starts off screen, and ends off screen.  Indeed, if it does not the 
roll or crawl must be rendered as a movie, called as you know an Animated title. 
Sometimes however you may want the scrolling to be different.  At the end of a roll you 
may want to stop and hold on a logo, or during the roll you may need to change speeds at 
some point.  This is possible by animating the Scroll position.  Animation is covered in 
the next module, and there you will learn how to animate the Scroll position. We will 
however look at how to change the scroll position here.  
 
There are two ways to change the 
scroll position. 
 
The first method is to use the Text 
Properties viewer. The scroll position 
is available here. If a text field has 
been selected with the Edit tool, then 
as you change the scroll position value, 
you will see the font reposition on 
screen.  
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The second method to change the scroll position is to use the scroll position slider which 
you can call up. To see this slider attached to your scrolling text, deselect the text field 
and then activate the Text tool.  
 

 

 

  
Text field with Scroll position slider at the left. Close Up of the 

Scroll position slider 
 
As you change the scroll position using either of these methods, you are changing the 
titles scroll position property. This is one of the things that makes the title an animated 
title, which takes longer to render and is less flexible than a regular Roll or Crawl.   
 
We do not use the scroll position as a tool to view the hidden portions of our roll or 
crawl. We use it when we want to alter the default animation of the roll or crawl.  To  
view hidden text in a roll or crawl text field, we activate the text field with the Text tool 
to bring up the scroll bars.  
      
 
 
Adjust Roll and Adjust Crawl buttons 
 
We saw that clicking the Roll or Crawl buttons made a valid text field for a roll or a 
crawl in your title.  These buttons may also be used to modify an existing text field so 
that it is a legal Avid Title Roll or an Avid Title Crawl which can be created without 
extensive rendering.  Remember, you don’t need to have a ‘legal’ roll or crawl, in that 
case an ‘illegal’ roll or crawl simply means it will be rendered as a movie. 
 
Select a text field and click the R or the C button in the Toolbox and Marquee will 
attempt to setup the title as a Roll or a Crawl using that object. It will adjust its scroll 
position to start at 0 and end at 100, it will adjust its height to fill the frame, and so on.  
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If there is some problem that requires your attention before this task can be completed, an 
error message will appear warning you that something needs to be changed. Make the 
change and try again!  
 
 
 
Saving a Rolling Title or a Crawling Title 
 
FILE > SAVE TO BIN will save your title to the Avid application as usual. When you go 
to save a Rolling Title which has some characteristics which will make it render as a 
movie, this dialogue box will appear: 
 

 
 
This does not mean you cannot proceed, it just indicates that the roll or crawl is of such 
complexity that each and every frame needs to be rendered out, and this will result in 
outputting an Animated movie which will be the title.  If this is OK, press OK.  If not, 
press CANCEL and fix any problem which is creating the Animated title unnecessarily.  
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Crawling Titles 
 
A crawling title has much in common with a rolling title.   
 
 
Creating a Crawl 
 

• Create a text field.  With the Text tool, right click inside the text field and 
chose MOTION > CRAWL 

• Click the CRAWL ( C )  button in the Toolbar to create a Crawl text field 
• Select an existing text field and press the CRAWL ( C ) button in the 

toolbar to modify an existing text field into a Crawl text field 
• From the STYLES library, chose one of the specially programmed crawls 

to fly text ON and OFF the screen 
• From the Templates Library, choose one of the preset Crawl templates 

      
 

 
New Crawl text field with no text yet entered Crawl text field with text entered, 

and scroll bar now visible 
 

Crawl text field with Scroll position arrow 
visible.  This is done by deselecting the text 
field (click away from it with the Edit tool) then 
activating the Text tool 

 
 
The Crawling Font disappears- scrolling through the Crawl 
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When you choose the EDIT tool, your font disappears. This is again because Marquee is 
setting your crawl up at its start position, where all the font is off screen. To see your font 
again, choose the TEXT tool and click on your text object. The font, along with the scroll 
bars, reappears.  
 
You may also scroll through the ‘timeline’ for the crawl by clicking and dragging on the 
time position numbers in the lower right corner of the Monitor window.  Click and drag 
back and forth to rock through the crawl.  Hold SHIFT to move more quickly, hold 
CONTROL to scroll more slowly.  
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Setting the Crawl Scroll position 
 

This is done as with a Roll. 
 
Use the Text Properties viewer to 
adjust the scroll position 
 

 
The second method to change the scroll position is to use the scroll position slider which 
you can call up. To see this slider attached to your scrolling text, deselect the text field 
and then activate the Text tool.  
 

 
  
Text field with Scroll position slider at the left. Close Up of the 

Scroll position slider 
 
 
    
Adjust Roll and Adjust Crawl buttons 
 
The Crawl button may also be used to modify an existing text field so that it is a legal 
Avid Title Crawl. Select a text field and click the C button in the Toolbox and Marquee 
will attempt to setup the title as Crawl using that title object. It will adjust its scroll 
position to start at 0 and end at 100, it will adjust its width to fill the frame, and so on.  
 

 
 
If there is some problem that requires your attention before this task can be completed, an 
error message will appear warning you that something needs to be changed. Make the 
change and try again!  
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Saving a Rolling Title or a Crawling Title 
 
FILE > SAVE TO BIN will save your title to the Avid application. When you go to save 
a Crawling Title which has some characteristics which will make it render as a movie, a 
crawl warning dialogue will appear.  You may proceed to render an Animation, or cancel 
and fix whatever is causing the title to render as a movie instead of an Avid Crawling 
Title.  
 
 
 
 
 

Text on a Path 
 
 

 
 
Path text offers a lot of creative value for little effort.  Marquee makes it very easy to 
place text on shapes- or paths.  These can be geometric shapes – squares or circles you 
draw with the Rectangle or Ellipse tools.  Or you can use the Pen tool to create any 
custom shape you want.  Text placed on these shapes can be static, or by assigning it as a 
Crawl you can animate the text to move along the shape you create.  
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Path Text involves following these simple steps: 
 

• Create a shape 
• Convert it to a path 
• Use the text tool to add text to the path 
• Assign the text as a crawl and position or animate the letters 

 
 
 
Crate a Shape for your text 
 
Using the Ellipse, Rectangle or Pen tool draw a shape upon which you wish to place your 
text. The shape can be edited with the pen tool either before you turn it into a Path, or it 
can even be edited after you have converted it to a Path and placed your text on it! 
 
 
 
Convert your shape to a Path. 
 
This is simple:  
 

• Select your shape and choose OBJECT > CONVERT PATH TO SHAPE.  
 
The object disappears, and you are left with an outline – the path of the original object. 
 
 
 
Add Text to your Path 
 

• With the path selected, chose the Text tool. A text cursor appears on the 
path and you may begin typing. 

• Without the path selected, place the text tool over the shape until you see 
the Path Text cursor, and click on the shape  

 
To control the position of your text on the path, you need to make it a Crawl and then 
adjust the Scroll position, as described next. 
 
 
 
Assign the text as a crawl 
 
To position your letters or animate them along the path you need to make them a crawl.  
In this case they will not crawl across the screen as they typically do, but will slide along 
the path you have placed them on.  
 

• With the text tool, right click on the letters and choose MOTION > CRAWL.  
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Adjust position of the text on the path 
 

• Chose Left, Centre, Right or Full justification to position your text at these 
positions along your path. 

 
We may also use the Scroll position to adjust the position of the letters on the path.  
 

• Begin by deselecting the path text.  
• Choose the Text tool from the Toolbox 
• Adjust the scroll control which will become visible n the Monitor 

window 
 
 
 
Reverse Motion and Position 
 
With the Pen tool, select the 
path upon which the text has 
been placed. When the path is 
visible with all its nodes 
(boxes) present, right click on 
the path and choose 
REVERSE. The font will flip 
to the other side of the path, 
and will reverse its direction.  
Compare this image to the 
original at the start of this 
section.  
 
 
 
 
 
Here are some other tips for Path text: 
 

• Text on a path may be changed (edited) in the normal way.   
• Paths may be edited at any time using the Pen tool techniques we looked 

at earlier.  
• You can only move the text path UP or DOWN on the screen.  To move it 

Left or Right, hold SHIFT as you drag. 
• Adjust the Baseline of the text in the Path Property Viewer 
• Adjust the letters to Follow or appear Upright in the Path Property Viewer 
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EXERCISE 11 
 

• Create a ROLL. Adjust its duration. Output it to the AVID 
• Create a CRAWL. Adjust its duration. Output it to the AVID 
• Draw a shape over an image, convert it to a Path, and place text on 

this path. 
• Using the DVE with the earth texture from the last lesson, draw a 

circle around the earth, convert it to a path, type text on it then lay 
it down so the text appears to encircle the earth.  Your instructor 
may need to help you with this one! 
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Module 12. Animation 
 

Introduction 
 
Now that we are confident we can create objects, we will explore how to move them 
around. This is done by creating keyframes, and allowing Marquee to change values 
between keyframes. 
 
Normally, if we change a value in Marquee the change affects the whole title. In contrast 
to this, a keyframe stores property values only at a certain point in time.  With two 
keyframes, Marquee will smoothly change property values from the first keyframe’s 
value to the second keyframe’s value.  This is how we create animation.  
 
There are two interfaces for creating Animation.  Animation Mode and the Timeline.  
 
The Animation Mode is activated by pressing the Animation button in the Toolbox 
(shortcut A).  In this mode, you simply move things around the frame, and scroll through 
time, and Marquee creates keyframes and therefore your animation without you needing 
to even see the timeline.  This approach is suitable for simple animations, or for creating 
the first rough of a more complex animation. This is the only practical method for 
creating animation in Marquee!  
 
For more control you may want to know about the Animation Timeline and how to work 
with it.  The timeline window will allow you to see your keyframes on a traditional 
timeline.  You can move them, change their values, delete them and create new ones.   
 
The Timeline interface is very limited however, and you are advised not to plan to use it 
as frequently as you use the other Avid timelines.  It is suitable for finding, moving and 
deleting keyframes only.  Since you can’t copy and paste keyframes (!) the interface is 
actually of little value beyond this.  Your instructor will probably skip the discussion of 
using the Timeline, although it is covered here in the text.  
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Animation Mode 
 
ANIMATION mode allows keyframing, a concept you may be familiar with from your 
AVID and After Effects experience.  
 
Marquee sometimes makes keyframes when you move things, and sometimes not.  How 
do we decide if we want Marquee to create keyframes or not ? 
 
This is determined by whether the 
ANIMATION button is activated (in 
which case it is RED) or not. The 
animation button OFF indicates the 
changes you are making are global 
(for the entire animation).  The 
animation button ON indicates the 
change is for that position in the 
timeline only, and if there is not 
already a keyframe there, one will be 
made for you.  

• Activate full toolbar VIEW > 
TOOLBOX > FULL 

• Click on ANIMATION MODE 
button  or  press A   It toggles 
between RED (animation mode 
ON) and Gray (animation mode 
OFF) 

    
Animation Mode 

OFF     
 

 
Animation Mode 

ON 

 
 
Without opening the timeline it is possible to program simple animations. You simply 
turn on the animation button, scrub to different positions in the timeline and make your 
changes directly to the objects in either the Monitor Window or the Property Windows.  
 
While this technique is fast and intuitive, it is difficult to make changes and determine 
exactly what is happening as you don’t see a timeline with keyframes.  With these 
limitations in mind, here is how to animate this way: 
 

• Your animation duration is set at 5 seconds by default.  If you need more or less 
time, select FILE > PREFERENCES > CURRENT TITLE and change the 
duration value for your unseen timeline.. 

• The time display in the status bar (lower right of Monitor Window) can be 
‘scrubbed’ to move forward and back through your currently invisible timeline.  
For slower, more precise motion hold CONTROL as you drag. For faster 
scrubbing, hold SHIFT as you drag. 

• Scrub to an appropriate position in the animation, and use the monitor window 
controls (such as Edit arrow to move, Rotate tool to rotate), or use the 
TRANSFORM palette or indeed any Property Window to make changes at that 
position. Repeat for as many positions as necessary.  

• With the Monitor Window highlighted, press the SPACEBAR to preview the 
result 

• To make a global change (move the entire animation to a new position for 
example) turn the Animation Mode button OFF and make your change.  
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Timeline Animation 
 
 
While the above procedure is OK for simply animations, or for roughing out a more 
complex move, we will need to see and work in our timeline for most animations.   
 

         
 
As an example, we will be taking this “Wild Marble” title and rotating it around the Y 
axis.  It is a single layer, consisting of a group of three objects: two pieces of text and a 
DVE Sphere.  
 
We begin by opening the timeline by pressing CONTROL + T or selecting WINDOW > 
TIMELINE from the Menu’s.  Two toolsets are setup for animation as well, select the 
animation toolsets from the Toolset menu, or choose F4  or  F5 to access them from the 
keyboard. 
 

 
Initial Timeline for the Wild Marble Title 

 
 
 

The timeline has three separate areas: 
 

• Object Properties on the left 
• Object Tracks on the right 
• Transport Controls on the bottom 
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Invariably we begin on the right in the Object Tracks part of the display.  
 

 
 

TIME TRACK  Current Time at the left, time tape at the right. Click and drag here to 
position Play head 

   

LAYER INDICATOR  Currently selected layer appears in Green 
   

SOLO  Show only this layer  (not selected) 
   

MUTE  Hide this layer (not selected)  
   

EXPAND  Show objects inside this container 
 
We know the layer L1 named “Rotating Marble & Text” contains three objects combined 
into a group.  To see the group and animate all three objects together we need to step into 
the layer once.  
 

 
 

EXPAND  Steps INTO the container to which it is attached 
   

COLLAPSE  Steps OUT of the container to which it is attached.  
 
To see the keyframes and animation curves we create, we need to Show Curves:  
 

 
 
SHOW CURVES  Displays the Property Curves for the container to which it is attached. You may 

also drag the top of the layer UP to expand the track More than one track may 
be expanded or opened at a time 

 
 



AVID Marquee Training       Paul Sampson, TVC, Toronto                   1/1/2007 135

What You Can Animate 
 
Any title may have multiple objects, and each object can have multiple parameters 
animated. Some programs, like After Effects, provide a separate track and graph for each 
animateable parameter. Marquee is different: it only ever shows one graph per object, and 
you tell it what parameter or parameters you wish to see in the one graph space.  To see 
an animation graph: 
 

• Select the object 
• Select the Parameter(s) 

 
 
 
Selecting an Object 
 
Use the Timeline’s Layer  Expand / Collapse   buttons to expose the track for the 
Object you wish to animate, then click its Show Curves button  to show the graph for 
that object.   When navigating around the timeline layers, you may select layers and 
objects by: 
 

• Click on the objects Layer in the Timeline 
• Click on the object in the Monitor Window 
• Click on an object in the Layers Palette 

 
 
 
Selecting a Parameter 
 

    
    

Properties with 
Transform category 
highlighted 

Click on + opener beside 
Transform to reveal 
what transforms can be 
animated 

Click on + opener 
beside Rotation to see 
what can be animated 

Place a check mark 
beside Y ROTATION to 
display its graph and any 
keyrfames that mightbe 
present. 

 

 
Graph area showing new curve for ROTATION 
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The graph above shows rotation, but notice the scale values only show from 0 to +180 
and from 0 to –180 degrees. To do a full rotation, we need to see a full 360 degrees or our 
keyframes will be off scale: 
 

 
Graph area showing final curve for ROTATION 

 
To control graph magnification, use these five tips, all which require the mouse cursor be 
within the timeline boundaries: 
 

UP Arrow Scroll UP graph to higher number 
  

DOWN Arrow Scroll down graph to lower number 
  

SHIFT + UP ARROW Increase graph scale 
  

SHIFT + DOWN ARROW Decrease graph scale 
  

RIGHT CLICK ON GRAPH Select RESET PAN /  ZOOM to set graph back to normal 
 
You may also increase the size of the graph window by dragging its top edge.  
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Working With Keyframes 
 
Keyframes appear as small boxes on the property graph line.  A hollow box 
is a keyframe, a solid box is a selected keyframe.  More than one keyframe 
may be selected, so that groups may be deleted, moved or modified together.  
 
 

Create a 
Keyframe 

• By direct Manipulation- just park and change a parameter while in 
Animation Mode 

• ALT + CLICK on property line 
• Position mouse near property line and an UP arrow icon appears.  

Right click at this moment and select “Insert Key” to create a 
keyframe at the position of the Arrow.  Notice it is not necessary 
to park where you want a new keyframe.  

  

Select a 
Keyframe 

• Select One: Click on a keyframe 
• Select Multiple: SHIFT + CLICK on several keyframes 
• Select All: CONTROL + A  or  RIGHT + CLICK on graph and 

choose “Select All Keys”  from the context menu  
  

Toggle a 
Keyframe 

CONTROL + CLICK to toggle keyframe selection ON and OFF 

  
Deselect a 
Keyframe 

Click in the graph but not on a keyframe 

  
Delete Keyframe Select the keyframe and press DELETE 

  

Move a 
Keyframe 

• Position cursor over keyframe so an UP arrow icon appears, then 
drag in any direction 

• Drag keyframe vertical bar to move UP/DOWN only (change 
value). A double headed UP/DOWN icon appears as you drag 

• Drag keyframe horizontal bar to move LEFT/RIGHT (change 
position). A double headed L/R icon appears as you drag. 

• Hold SHIFT as you drag to move only along preset frame and  
interval values 

  

Change 
Keyframe Value 

• Drag a Keyframe UP/Down 
• Drag the object in the Monitor Window 
• Change the value in a Property Window 
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Creating Multiple Keyframes 
 
If you look closely at the Object Properties window, you will see 
that to record an objects position, you need to create three 
keyframes – X, Y and Z position.  If you turn all three properties 
on at once, their graphs could potentially overlap in the Property 
graph and they could interfear with each other. To create 
keyframes, you could turn each of these properties ON one at a 
time, but that would be very difficult to manage.  

 
 
 

 
 
Instead, we have four special new Keyframe buttons at the bttom of the timeline which 
will make more than one keyframe at a time for our convenience:  
 
Button Name  Description  

 Add X, Y, Z Position 
Keyframes  

Adds keyframes to the X, Y, and Z Position property 
curves at the current location of the position indicator.  

 Add X, Y, Z 
Rotation Keyframes  

Adds keyframes to the X, Y, and Z Rotation property 
curves at the current location of the position indicator.  

 Add X, Y, Z Scale 
Keyframes  

Adds keyframes to the X, Y, and Z Scale property curves 
at the current location of the position indicator.  

 Add RGB Main 
Color Keyframes  

Adds keyframes to the R, G, and B Main Color property 
curves at the current location of the position indicator.  
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As a summary, here are the cursor functions in the timeline when working with 
keyframes: 
 

UP ARROW means  you can click to select – and 
move in ANY direction- there are no constraints 
 

 

UP and DOWN arrow – move KF UP and DOWN 
only, change KF value 
 

 

LEFT RIGHT – move KF left right to change 
keyframe position 
 

 
TRIM rollers appear at edge so you can change 
DURATION of object 
 

 
 
 

Controlling Keyframe Velocity 
 
Keyframe Velocity (speed) is controlled in different ways in different programs. In the 
Media Composer, we have Acceleration and Spline. In After Effects we directly edit 
Velocity graphs in the timeline.  Marquee is very much like After Effects in that we 
control speed of our move by keyframe position and keyframe velocity graph shape.  
 
We create the 
initial rotation, and 
these keyframes 
indicate the move 
is a linear (and 
abrupt) rotation 
through 360 
degrees.  
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To create a smoother move, we can use the SMOOTH 
feature.  Right Click on a line between two keyframes, 
and from the context menu select SMOOTH. You have 
four choices:  

 
EASE IN – Smoothes left KF 
EASE OUT – Smoothes right KF 
EASE IN AND OUT – Smooths both KF 
WHOLE CURVE – Smooths all keyframes in 
graph 

 
Notice this EASE is the REVERSE logic of After 
Effects, where an EASE IN  would create a handle on 
the left of a KF not on the right.  

 

 
 
The resulting 
motion on screen 
is smoother, and 
the graph shows 
this.  It also has 
two new ‘handles’ 
which can be 
manipulated to 
further fine tune 
the speed of the 
movement around 
these keyframes. 
 
Once a keyframe has a handle, ALT + DRAG out of the keyframe to expose its hidden 
handle on the other side of the Keyframe.  
  

The Smooth feature is just a shortcut. Actually, it is assigning 
a curve type to more than one keyframe at a time as a 
convenience to you. There are five curve types, and you can 
also assign them manually. 
 
To set a curve type, right click on a keyframe (or on the line 
to its right) and select the curve type from the context menu.  
Select more than one keyframe before doing this if you wish 
to assign a curve type to multiple keyframes.  

 
 
 

 
HOLD Value jumps to new setting at each keyframe 
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LINEAR Value varies linearly between keyframes 

   

 BEZIER 

Value varies more smoothly. Curve passes through 
keyframe, has handles to be editable, values can 
change smoothly or drastically at each keyframe.  
Changes are limited in their effects on other 
keyframes. 

   

 B-SPLINE 

Smooth movement by the program.  No handles 
for editing, graph may not pass through keyframes 
(may not actually hit programmed positions) but 
changes are always gradual.  Changes to one 
keyframe may effect many others.  

   

 
CARDINAL

Smooth movement by the program, but path does 
pass thorugh keyframes (will hit all pre-
programmed positions). No handles for manual 
editing. 

 
In many of the above cases, you may need to assign one of the settings to three adjacent 
keyframes so the middle on of the trio will display all the attributes of the curve type.  
 

 
Animation Tips 

 
To Save Rendering 
 
If you have an animation which has a long hold at the top, some movement, and a long 
hold at the tail, we can speed up rendering by saving it as three objects into our bin. We 
can save a static title for the top, which we can edit to any duration we want.  We can 
save the move only as a single animation.  We can then save the last frame as a static 
frame and also edit it to any desired duration.  
 
When you go to save your animation this box 
appears. Save the FIRST and LAST frame of 
your animation after setting a checkmark in the 
current frame only checkbox. Then remove this 
checkmark and save the moving animation as a 
fully rendered movie. 
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In the editing system, edit in a few seconds of the top static title, edit in the animation, 
edit in the last ststic title. While this sounds like a lot of work, it offers two significant 
advantages. 
 
First, you reduce render time coming from Marquee. 
 
Second, you can now trim the Top or Tail of your title without needing to do any re-
rendering. The static titles on the beginning and the end offer us a buffer who’s length we 
can change without needing to return to Marquee for a re-render! 
 
 
 
Using MARKS on the Timeline 
 
Once we are working in the timeline, we have access to a few familiar and a few new 
buttons.  The familiar buttons are mark IN and Out, erase IN and OUT, Go To IN and 
OUT, PLAY, PLAY IN to OUT, GTO HEAD, GOTO TAIL. You can see them all 
below.  
 
Why mark IN and OUTpoints on the timeline ?  There are two reasone we will discuss 
here: 
 

• To designate the parts of the timeline a SCRIPT is to operate on 
• To designate what part of a property to fade UP and DOWN on. 

 
 
DeleteKeys and MoveKeys 
 
The Script library contains two scripts which operate on the timeline.  DeleteKeys and 
MoveKeys. Both do what you would expect on a group of keyframes indicated by the 
current marks in the timeline.  Delete Keys will find all keyframes on any property within 
the timeline and delete them. You don’t need to hunt down keyframes in a range 
manually.  Similarly, MoveKeys will present a dialogue where you can enter the distance 
you wish to move all keyframes in a range.   
 
Simply place your marks around the appropriate range in the timeline, and double click 
on the scripts name in the library window to run it.  
 
 
 
QuickFade 
 
From the timeline, you can quickly fade objects IN, OUT or both IN and OUT.   
 

• Begin by placing marks to indicate the art of the timeline you wish 
an object to be visible for.  

• Click QuickFade . A fade IN begins at the start of the objects 
property Graph, and ends at the Mark IN.  A fade OUT begins at 
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the mark OUT and ends at the end of the Objects Property graph, 
as shown below.  

 

  
 

You don’t need to select properties or do any other preparatory work. The QuickFade 
button places keyframes and adjusts the Master Opacity on the object.   
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Keyboard Shortcuts 
 
 

FONT 
 

ENLARGE SELECTED FONT CTRL + SHIFT + > 
  

REDUCE SELECTED FONT CTRO + SHIFT + < 
  

INCREASE LEADING ALT + UP ARROW 
  

REDUCE LEADING ALT + DOWN ARROW 
  

INCREASE PARAGRAPH SPACING ALT + SHIFT + DOWN ARROW 
  

REDUCE PARAGRAPH SPACING ALT + SHIFT + UP ARROW 
  

INCREASE KERNING ALT + RIGHT ARROW 
  

REDUCE KERNING ALT + LEFT ARROW 
  

When typing, the ENTER key creates a line break of the type you might use to separate names in a list.. 
When typing SHIFT + ENTER creates a paragraph break, which usually has greater spacing than a line break. 

 
 

ADJUSTING BEZIER HANDLES 
 

EXTEND HIDDEN HANDLE ALT + DRAG out of keyframe 
  

UNLOCK HANDLE PAIR ALT + DRAG  a handle 
  

LOCK HANDLE PAIR CONTROL + CLICK a handle 
  

CHANGE HANDLE LENGTH ONLY SHIFT + DRAG the handle  
  

SHRINK HANDLE TO 0 RIGHT + CLICK on keyframe and select MAKE CUSP 
 
 

ANIMATION SHORTCUTS 
 

HOME Go to start of timeline 
  

END Go to end of timeline 
  

SPACEBAR Play timeline 
  

[ Go to previous keyframe 
  

] Go to next keyframe 
  

UP Arrow Scroll up property graph 
  

DOWN Arrow   Scroll down property graph 
  

SHIFT + UP ARROW Increase magnification of graph scale 
  

SHIFT + DOWN ARROW Decrease Magnification of Graph scale 
  

Right Click and select RESET PAN / ZOOM 
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MISCELLANEOUS 

 
ARROW Keys  nudge selected object 
  

CONTROL =   Zoom IN 
  

CONTROL –  Zoom OUT 
  

CONTROL A Select All 
  

Single click in a number 
field  

to position cursor 

  

Double click on a number 
field  

to select current entry so your typing will 
replace it. 

  

CONTROL + \ (in Monitor Window) to Preview your work 
 


